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PART ONE
Introduction and Installation
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Introduction : Otoacoustic Emissions

The basics
Otoacoustic emissions are sounds which can be recorded in the ear canals of
functionally normal ears.  They are the result of compressions and rarefactions of the
air in the ear canal due to movements of the ear drum.  Of course the ear drum
vibrates as we speak and breathe and as our hearts beat.  All of these movements
result in sound which can be detected in the ear canal.  Otoacoustic emissions are
special because they result from ear drum vibration driven by the inner ear.  Prior to
1977 no one suspected that ear drum vibration BY the cochlea was a part of the
normal hearing process.  We now know however that in order to achieve its exquisite
sensitivity to sound the cochlea must actively manage the sound energy it receives
and direct the individual frequency components to the appropriate sensory cells which
lie along the Organ of Corti.

The flow of sound energy through the cochlea happens relatively slowly.  The so called
travelling wave takes a few milliseconds to travel the three centimetre or so length of
the human cochlea.  In this time, the external sound has travelled a further metre or
more.  Von Bekesy was the first to describe the cochlear travelling wave but he also
noticed that it tended to die away before reaching its peak of vibration.  More recent
measurements in healthy live ears have shown that the travelling wave can build up as
it travels to exceed the vibration entering the cochlea at the oval window by hundreds
of times.  This rapid build up in travelling wave energy is only found in healthy
cochleas where the outer hair cells are in perfect condition.  Any insult to the cochlea
or disease tends to rapidly depress the travelling wave size.  This leads to a decrease
in sensitivity and elevation of hearing threshold.

It appears that the cochlea cannot completely contain all the energy from the
enhanced travelling wave.  A fraction of this wave scatters back to act upon the middle
ear rather than the sensory cells.  Although this is wasted energy from the point of view
of cochlear function, it is extremely valuable in audiology because it gives us a way of
detecting the presence of a strong travelling wave.  As the scattered back travelling
wave impinges on the oval window it moves the middle ear and consequently the ear
drum.  The oscillations of the ear drum move the air in the ear canal.  This on its own
would generate very little sound because the air can move freely in and out of the ear
canal.  When the ear canal is closed by the otoacoustic emission probe a substantial
sound pressure is developed as the small trapped volume of air is periodically
compressed and rarefied by the ear drum motion.  Otoacoustic emission sound levels
recorded in this way can sometimes exceed 30dBspl - an audible level!
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Otoacoustic emission sounds have very particular characteristics which derive from
their origin in the cochlear travelling wave.  Firstly, as these vibrations derive from the
original sound stimulus they are synchronised to it and contain the same frequencies
as the stimulus.  Secondly, as they originate from the slowly travelling wave deep
within the cochlea they emerge with a delay or latency usually of several milliseconds.
Finally, as the internal strengthening of the travelling wave is due to the action of the
sensory cells within the Organ of Corti they exhibit the typical biological characteristic
of non-linearity and saturation.  This results in two important characteristics of acoustic
emissions.  The output strength of acoustic emissions is found to saturate with
increasing levels of stimulation.  For example with a stimulus level of 10dBspl the
acoustic emissions level could be 5dBspl.  If we now raise the stimulus level to
40dBspl we might find that the otoacoustic emission level had risen only to 15dBspl, a
rise of only one third of the decibel input increase.  This distortion of the relation
between output and stimulus also occurs rapidly with each wave of the stimulus.  The
consequence of this is a distortion of the individual oscillations occurring in the cochlea
and this generates inter-modulation distortions (similar to ‘beats’).  The emerging
otoacoustic emissions therefore contain frequency components not presented to the
ear but generated internally by a distortion process.

These characteristics of otoacoustic emissions help us to measure them efficiently and
discriminate between otoacoustic emission sounds and other sounds of environmental
and physiological origin.

What can we learn from OAEs?
Because otoacoustic emissions are a natural by-product of a strong cochlear travelling
wave, their appearance in the ear canal helps us to confirm normal function of a large
part of the peripheral auditory system.

Because we know otoacoustic emissions are presented to the ear canal through ear
drum motion they confirm normal mobility of the entire middle ossicular chain.  In
contrast to tympanometry, the mobility of the oval window and the stapes is as
important to the final result as mobility of ear drum; but OAEs are not a measure of
middle ear function.  They are a measure of the level of activity inside the cochlea
related to the strengthening of the travelling wave.  The presence of otoacoustic
emissions therefore confirms that the general anatomical and physiological
environment of the inner ear is able to function normally.  This includes the Basilar
Membrane, the structure of the Organ of Corti and the health of the outer hair cell
system.  The latter requires the endolymph to have been properly conditioned by the
action of the Stria Vascularis.  It is universally observed that otoacoustic emissions are
depressed whenever the status of these systems is degraded.  However, no way has
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so far been found for differentiating between types of cochlear dysfunction or
pathologies using otoacoustic emissions.  The presence of otoacoustic emissions must
therefore be seen as evidence for the functional integrity of the entire middle ear and
cochlear system up to and including the outer hair cells.

A  most important feature of otoacoustic emissions is their synchronisation to the
stimulus.  The OAE signal is highly frequency specific to the stimulating sound, in
contrast to evoked responses of neural origin.  This frequency specificity permits the
use of powerful signal extraction and processing techniques which lie at the heart of
otoacoustic emission instrumentation.  It means for example that we can extract the
multiple responses of the cochlea at a wide range of frequencies simultaneously by
frequency analysis.  We are not restricted to having to use pure tone or toneburst
stimuli.  We may use complex stimuli such as clicks and multiple tones to stimulate the
ear and still extract the individual frequency components of the cochlea’s response.

Otoacoustic emissions can therefore provide highly frequency specific information
about the cochlear response.  Laboratory studies have shown that the otoacoustic
emission response of the ear to a particular frequency is largely generated in a place
specific region of the cochlea.  Clinical studies have shown that otoacoustic emissions
fail to emerge at frequencies for which there is substantial hearing loss.  Using
otoacoustic emissions we can therefore map out the good and bad regions of cochlear
function.  This can be achieved with the presentation of either a complex broad band
stimulus or a serially presented set of tonal stimuli.  The good frequency specificity of
otoacoustic emissions does not translate perfectly into a cochlear place specificity.
The creation of the back scattered wave is a complex process.  Furthermore, when we
present even a pure tone to the cochlea the internal travelling wave stimulates a broad
region of the cochlea - perhaps as large as 30% of the entire sensory cell population.
It is incorrect therefore to consider that the use of precisely defined pure tones targets
a precisely defined place or group of cells in the cochlea.  Nevertheless it has been
shown that there is a useful ‘place specificity’ of otoacoustic emissions which allows for
a general correlation between frequency regions of otoacoustic emission activity and
frequency regions of normal audiometric threshold, but not between the OAE levels
and hearing threshold.

Although we cannot reconstruct the audiogram by using otoacoustic emissions, we can
detect quite small changes in cochlear status.  An individual’s otoacoustic emission
response is highly individual and very specific to the intensity and spectrum of the
stimulus sound.  If the latter two are kept constant then changes in the acoustic
emission with time are a sure indicator of changes in the physiological status of the
peripheral auditory system.  This property has been used as a sensitive indicator of
changes caused by noise or therapy on a patient’s ear.  However, it must be
remembered that a change in otoacoustic emission is as likely to be caused by a
change in middle ear status as by a change in cochlear status.
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What can I NOT do with OAEs?
The presence of otoacoustic emissions cannot be used to infer functional normality of
any part of the auditory system beyond the outer hair cells.  The inner hair cells play
no part in the generation of OAEs so far as we know.  As the inner hair cells are the
primary sensory cells of the inner ear, they largely determine hearing threshold
through their synapses with the auditory nerve.  While a strong cochlear travelling
wave is a necessary ingredient for normal sensitive hearing, it is not sufficient in itself
to guarantee that any hearing function occurs.  A defective inner hair cell population or
auditory nerve will result in a greatly elevated threshold even with strong otoacoustic
emissions.

It is an accident of biology that the vast majority of sensory hearing impairments are
located in the cochlea and negatively affect the function of the outer hair cell
mechanism.  Otoacoustic emissions therefore are successful in detecting the vast
majority of sensory hearing impairment.  They cannot, however, be used to predict the
audiometric threshold of a patient.  While the presence of otoacoustic emissions
confirms normal function of middle and inner ears so far as sound vibration is
concerned, their absence cannot be used to locate the nature of any disorder in the
system.  OAEs cannot be used to detect retro-cochlear disorder in normal clinical use.
An ear with OAEs may also have a retro-cochlear lesion.  An ear with a retro-cochlear
lesion may or not have normal otoacoustic emissions.  OAEs are therefore a valuable
addition to the diagnostic process and not a replacement of previously trusted
methods.

TEOAEs and DPOAEs - what’s the difference?
The technical jargon sometimes gets in the way of the simple fact that the healthy
inner ear produces OAEs and an ear with sensory hearing loss generally does not.

Of course, the middle ear has to be working efficiently if we are to see OAEs at all, so
that OAE testing is really a test of the functional integrity of the whole peripheral
auditory system, including the middle ear.

To test the ear with OAEs we must first give it a sound and it’s here that the technical
jargon begins!  If we give it a brief transient sound, we can make use of the natural
delay of all waves in the cochlea to pick out the cochlea’s own sound from the stimulus
delivered.  This is an echo-sounding technique where we send a brief pulse of sound
in and collect the delayed emission or echo from the ear.  This turns out to be a
technically simple task and is very sensitive to cochlea problems because we measure
the response in the quiet period between each transient sound.
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Alternatively, we can deliver a continuous sound to the ear and try to measure its
continuous response.  We can’t use the natural delay of the ear as easily and so it is
quite difficult to separate the continuous acoustic emission response from the
continuous driving sound.  It’s quite easy to recover at least a part of the OAE by
providing two continuous sounds at different frequencies.  The saturating acoustic
response of the cochlea (non-linearity) means that the emission is a distorted copy of
the sounds presented.  The distortion part can be separated by signal analysis and
has been shown to behave very similarly to the whole emission when it comes to
hearing loss.  This by-product of the inner ear, or ‘distortion product’ otoacoustic
emission, requires a higher complexity of equipment to extract but has potentially the
same clinical value as transiently evoked emissions, so far as we know.  There are
differences, however, in practical terms.

Firstly, it’s possible to deliver much more stimulus power with continuous tones than
with brief clicks.  This means that continuous tones can more easily be used to
squeeze an OAE out of a less than perfect ear.  This may seem like a disadvantage
clinically but in fact many older adult ears have reduced OAEs above 3K and DPOAE
analysis can be used to confirm that substantial useful function still remains.  The
lower sensitivity and higher specificity of DPOAE testing at levels of 60dBspl and
above therefore complement the high sensitivity and lower specificity of the TEOAE
method.  When testing young ears, TEOAEs offer the ideal characteristics, whereas for
testing older ears, TEOAE measurements should be followed by DPOAEs if the
TEOAE response is deficient.  TEOAEs are also more successful at recording low
frequency responses below 1kHz owing to technical considerations.  Balancing this,
the DPOAE signal extraction method is superior to the TEOAE method above 4-5kHz
and is therefore essential when screening for hearing loss above the speech range.

In summary, DPOAEs and TEOAEs are not different responses, but different
technologies for response measurement.  They each have their advantages and
disadvantages with TEOAEs alone adequate for newborn screening work and a
combination of TE and DPOAE more suited to clinical investigation with older age
groups.
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OAEs in service

Otodynamics OAE instrumentation
Otoacoustic emissions (OAEs) have become an important part of clinical audiology
and paediatric hearing assessment.  Around the world, hundreds of thousands of
newborns are tested each year using Transient Evoked OAEs (TEOAEs) and
Distortion Product OAEs (DPOAEs) and they are finding an increasing number of
applications in diagnostic audiology and hearing research.

OAEs are the only objective indicator of cochlear status at the level of the Organ of
Corti which is sensitive to small departures from normality.  Depending on the level of
stimulation and type of technique used, OAEs can detect hearing losses of between 20
and 30dB.  Not only are OAEs highly sensitive to peripheral hearing loss, they offer the
added bonus of frequency specific information.  The TEOAE recording method has
proved to be the most sensitive OAE technique and provides frequency specific
information from 500Hz up to 5,000Hz.  DPOAEs have slightly lower sensitivity but
higher specificity and complement TEOAEs in the clinical investigatory environment.

OAEs were discovered in a Department of University College London, known as the
‘ILO’, in 1977.  ILO otoacoustic emission equipment is available through Otodynamics
Ltd., UK.

Otodynamics continues to lead the field in both technology and product quality.  The
1997 range of OAE products includes fully integrated DP and TEOAE measurement
systems in both battery portable and desktop formats.  There are also a number of
TEOAE-only systems which meet the needs of rapidly growing newborn hearing
screening programmes both economically and effectively.

This manual
This manual contains important information on setting up and using your Otodynamics
OAE instrument.  It also contains important information about the background to OAEs
and their interpretation and use, both for screening and as part of the audiometric test
battery.  (See Hardware Installation Manual).

It is not the aim of this manual to provide a comprehensive guide to the clinical uses of
otoacoustic emissions.  The reader is referred to the growing body of literature on this
topic.  The primary aim of this manual is to ensure that the reader is able to conduct an
OAE recording session and correctly identify the presence of otoacoustic emissions.
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To make good OAE recordings some knowledge about the equipment and the
behaviour of sound in the ear canal is essential.   Like any physiological response
measurement system, otoacoustic emission instruments can give misleading and
sometime erroneous results if incorrectly used.  Signals which superficially resemble
real physiological signals but actually originate from non-physiological processes are
called artefacts.  Otodynamics instrumentation and software include a number of
safeguards and protections against artefactual responses.  Users should familiarise
themselves with the characteristics of otoacoustic emissions, the characteristics of
known artefacts and with the artefact detection and rejection facilities offered in the
software.

Product overview
The first commercially available OAE system provided TEOAE measurement facilities
only and was known as the ILO88.  Today’s TEOAE instruments are based on the
ILO88 but there have been a number of important changes in the hardware which
interfaces to the PC.  This has been in response to developments in the construction
and design of personal computers and has resulted in increased speed and also
reduced dimensions.  Otodynamics has re-engineered the ILO88 interface card, both
to fit into today’s smaller desktop computers and also to interface through the parallel
and serial ports of today’s laptop computers.  Rapid development has also occurred in
the software and memory capacity of personal computers.  The ILO88 programme
data has been revised to take full advantage of these changes but has remained
compatible throughout.  The Version5 ILO software described in this manual is capable
of running all previous Otodynamics ILO88 hardware to its maximum capacity.

The products ILO88,
ILO88i and ILO88
Echoport all reproduce the
original ILO88 functions
with the improved
convenience and capacity
of modern PCs.  They
provide TEOAE-only
facilities and owners of
these products should
disregard sections of this
manual dealing with
DPOAEs.

The products ILO88DP,
ILO88DPi and ILO292 DP
Echoport also provide the
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full TEOAE facilities of the ILO88 but in addition combine measurements of DPOAEs.
The ILO88i unit may be upgraded to the ILO88DPi unit at any time.

The ILO88DP series and the ILO292 DP Echoport instruments provide a unique
combination of TE and DPOAE measurements which we believe will provide the user
with the most comprehensive view
possible of cochlear mechanical status
available today.

Functional description

The ILO88 Otodynamics Analyser
performs an auditory screening
function by objectively testing for
normal function of the combined
middle ear and cochlea.  The
transducer assembly of the ILO88 is
similar to that used for middle ear
measurement in that it contains a
loudspeaker for stimulus presentation to the ear and a microphone for measurement of
the sound energy within the ear canal following stimulus presentation.  A band pass
filter is used to capture the appropriate frequency range for the test 500-6000Hz.
However, by selecting and measuring only those signals delayed by more than 2.5ms
after stimulation, the ILO88 is primarily sensitive only to sounds which have passed
through the middle ear, into the cochlea and then returned.  Non-linear signal
processing can remove residual acoustic signals from the stimulator, ear canal and
middle ear.  The ILO88 therefore primarily tests cochlear status.

Although good middle ear status is
essential for the passage of sounds to
and from the cochlea, the ILO88 does
not measure middle ear function and is
not a tympanometer.  The ILO88
performs the same function as an
automated screening audiometer in so
far as the system software identifies
cochlear function based on a
measured response to the given sound
pressure level and stimulus frequency.
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The delayed acoustic response of the cochlea measured by the ILO88 is commonly
known as an otoacoustic emission.

Operational description

a) The ILO88 acoustic probe, fitted with a disposable plastic tip, is inserted into the
patient’s ear.

b) A standard click stimulus is applied and the resultant sound in the ear canal is
displayed as a waveform and spectrum so that the operator can adjust the fit of the
probe and ensure proper stimulation for performing the test.

c) Following the fit check, the test is begun.  The preset stimulus is repeatedly applied
and the delayed sound field in the ear canal captured, digitised and accumulated in
the computer memory to enhance the detection of the small cochlear echo signals
against the background noise.

d) On termination of the test the accumulated response is displayed as a waveform on
the computer screen and also as a frequency spectrum for inspection by the
operator.  The responses are automatically tested for signal validity by methods of
*non-linearity and reproducibility.  The operator inspects the display for evidence of
otoacoustic emissions at the frequencies of sounds delivered to the ear and for
confirmation of valid test condition (e.g. acceptable levels of noise).

(*Explanation of signal processing - Biological signals are intrinsically non-linear or saturating.
Non-biological acoustic and mechanical responses are not.  Also true responses to the
stimulus are reproducible whereas noise signals are not.  Hence the ILO88 software can
identify true otoacoustic emissions and measure noise contamination.)

Interpretation of ILO88 results

The lack of a visible otoacoustic response in the waveform panel and the frequency
response panel of the ILO88 display can be caused by blockage of the probe,
blockage of the ear canal, excessive overlaid noise, middle ear dysfunction, or
cochlear dysfunction.  Lack of a response in the case of a properly functioning probe,
properly fitted in a clear ear canal and with low background noise,  indicates the need
for audiological investigation of the ear to establish the cause of the dysfunction.  A
frequency analysis is provided of both the validated response and the noise energy
present. This is useful in visualising otoacoustic responses in limited frequency bands.
The activity level of the cochlea and the level of background noise is shown as blue
and red respectively, permitting identification of the response at individual frequencies.
An OAE at one frequency should not be taken as evidence of normal cochlear function
at any other frequency.  It is possible for low frequency background noise to make the
whole OAE waveform unreadable but still allow the OAE response spectrum to show a
strong indication of a cochlear response at higher frequencies.  To summarise - the
operator should examine both the waveform and spectrum for evidence of cochlear
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responses across frequency.  They should examine response reproducibility to confirm
that response is true.  They should observe the measured level of noise contamination
before deciding if an OAE is absent (indicating further audiological investigation is
necessary) or is simply obscured by noise (indicating that a re-test is required).

Detectable otoacoustic emissions on the ILO88 provide objective evidence of function
of the cochlear mechanism and by implication also of the middle ear.  Otoacoustic
emissions are not normally present if hearing loss exceeds 20-30dB at the stimulated
frequency.  The absolute decibel level of OAEs is not in itself interpretable as it can be
affected by probe fitting and insignificant middle ear factors.  There is no particular
waveform of OAEs which is right or normal.  What matters is the frequency content of
the waveform. This can be estimated by eye but is best measured by spectral analysis.

Indications for use

The transient otoacoustic emission test conducted by the ILO88 is useful when
objective confirmation of cochlear function is required, as would be the case with the
screening of infants (including newborns) and with other patients unable to co-operate
with a hearing test, such as the mentally impaired or unconscious patient.  It is also of
use when it is necessary to know if a hearing impairment established by other means
(e.g. by BSER or subjective audiometry) involves or is accompanied by impairment of
cochlear function. Evidence of intact cochlear function in the presence of retrocochlear
hearing loss can influence the management of patients undergoing diagnostic
investigation, of candidates for surgery, and infants identified as needing amplification.
The ILO88 is not useful in cases of middle ear pathology and failure to show an OAE
can indicate cochlear OR middle ear dysfunction. The ILO88 is not useful in
determining the level of impairment and is therefore best regarded as a frequency
specific screener.
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ILO V5 software overview
ILO V5 OAE software is a Windows 95 and MS-DOS compatible program with the
capability of operating all previous types of ILO equipment to maximum capacity.
Please see the section entitled Version5 Software Installation for details of how to
install the program and also how to configure it to work correctly with your existing ILO
system, if you have one.

V5 OAE facilities - a brief review

ILO V5 software provides advanced TEOAE recording facilities and, on suitable ILO
equipment, fully integrated DPOAE recording.  There is enhanced memory capacity so
that up to 1,000 data recordings can be quickly reviewed and analysed with the
software.  TEOAE recording modes include the classic ILO88 mode, the
QUICKSCREEN mode, which is being used to great effect in newborn screening
programs, and a spontaneous OAE search facility which can be useful in
distinguishing between noise artefacts and unusually high level OAEs obtained from
some very active and healthy ears.  One new feature of the software is the pre-
programmed test termination facility, which allows the test sequence to be
programmed to continually monitor all measurement and response parameters and
automatically terminate the recording either if there are indications of technical
inadequacy or indications of strong otoacoustic emission presence.  This facility is
automatically active on start up and uses information read from a ‘stop logic’ file. Two
pre-programmed Stop files are provided, ‘Manual’ and ‘Quick’.  You may edit the
Quick Stop protocol in order to gain familiarity with its behaviour.  The protocol can be
edited either from the second ‘options’ screen of the opening selection box screen, or
from inside the ILO88 TEOAE program by selecting STOP LOGIC from the Settings
menu. The STOP LOGIC file can be pre-selected from the STOP LOGIC box on the
opening screen.

While exploring Version5 software, you may find it useful to press F1 for available help
on the topic in question.  While displaying the Stop protocol termination edit menu, F1
will provide a description of the usage of this facility.

Use of the automatic Stop system can aid in training and supervision in universal
screening programs by setting limits to the duration and stimulus at levels during tests.
More powerfully, by setting acceptable OAE levels for the specific program, tests will
be terminated when adequate information is obtained, usually saving valuable time per
baby by preventing unnecessarily long recordings.  With care, the user may set the
STOP LOGIC to indicate when the test result has satisfied the local screening criteria
or if the infant needs to be tested further.
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When a TEOAE recording has been automatically terminated, a message will briefly
appear on the screen, giving the reason for test termination, e.g. ‘good signal-to-noise
ratio’, or ‘too much noise’.  This message is saved with the data and is available for
further inspection.  It also briefly appears when the recording is retrieved from the data
store.

Another useful new facility in Version5 in screening programs is the score logging
system.  Each time a recording is made, an entry is made in a log file by the name of
‘Tested.log’ and the contents of this file can be reviewed after a recording session by
accessing the Score on the main opening box screen.  When this mode is activated, a
list is displayed containing one example from each case number or patient name.  A
case may be selected by pressing Enter and when this is done, the tests made on that
patient’s case appear in summary form.  The best recording for one of the two ears is
selected and the full data display is shown, along with a scoring tool bar.  The data is
evaluated by the doctor or audiologist as representing a pass, refer or a technical fail
requiring a re-test, by pressing keys 1, 2 or 3, followed by Enter.  At this point, a
confirmatory identity number must be entered and then this score is saved in a file by
the name of SCORE.LOG.  The scored ear is then removed from the list.  When the
other ear of the patient has been the scored, the case is removed from the list.  This
proceeds until all cases from the tested list have been scored and transferred to the
scored list.

The scores saved in the SCORE.LOG file (stored in the ILO-V5\ECHOPROG directory)
may be printed as a short report using any word processor.   The scored files can be
transferred to a separate directory for archiving.  This process is controlled using the
back-up button on the main opening screen.  This process of scoring was developed
by Otodynamics originally for the HI•SCREEN program developed by the National
Center for Hearing Assessment and Management.  The facilities just described,
however, do not themselves constitute the HI•SCREEN function.  For further
information on HI•SCREEN and linking the ILO system with the HI•SCREEN database,
please contact the National Center for Hearing Assessment and Management in Utah,
USA.

Making a TEOAE recording is simple with the ILO.  Activating the TEOAE box on the
opening screen will lead to the ILO88 display screen.  (If you do not have active ILO
hardware, you will be requested to confirm that the software operates in training mode.
In this case, answer Yes, with Y, and you will be invited to load a sample recording).

Collect Preset Mode:  This mode is set to the original ILO88 20ms sweep mode, but
can be modified to refer to any of the other modes by pressing Control Return on that
selection.

Original ILO88 Test:  Performs a click-evoked, non-linear TEOAE measurement on a
20ms time sweep and is ideal for research investigations and for capturing the lowest
frequency of OAEs.
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QuickScreen:  Uses a shorter timescale and a stimulus with medium frequency
emphasis to obtain the fastest possible screening operation.  The alternatives,
accessed by K or W on this line, provide respectively a form of QuickScreen which
saves the usually discarded linear component of the OAE and a modified low
frequency boosted stimulus.

Tone Pip Stimulus:  Provides a tone pip at the frequency requested and performs a
tone burst OAE.  The parameters of the tone pip may be modified with the third level
ILO menu access by pressing 3 for the main screen.

SOAE Activity Check:  Performs the search for spontaneous or lingering OAE
activity, which is often a component of TEOAE activity and can be confused with noise
artefacts.

Probe Cavity Test:  Used to confirm the frequency response of probes in frequent
use.

Linear Click:  Provides a uniform click stimulus for accessing the whole OAE without
non-linear processing (see detailed user instructions).

Non-Linear Click:  Duplicates the standard ILO88 function.

Various facilities are available to view and analyse the recordings.  Briefly, these are
accessed by pressing F3 - this provides a frequency analysis with cursor.  F5 provides
a time analysis with the cursor.  H provides a half-octave analysis of the response,
cancelled by W to restore the waveform.  R splits the screen, showing both the
waveform and frequency analysis.  Frequency analysis may be converted to one
octave, one-third, one-fourth, one-fifth, one-sixth, by pressing the keys 1, 2, 3, 4, 5, 6
immediately after pressing H, or by pressing Alt 1, 2, 3 etc. at any time.

DPOAE facilities

On appropriate equipment, DPOAEs can be recorded.  Press D from the Transient
OAEs screen, or select the DPOAE box from the opening screen.  The method of
recording DPOAEs is described further on in this manual.  Briefly, DPOAEs consist of
acoustic emissions in response to two-tonal stimuli.  These can have more intensity
than the TEOAE click and therefore can evoke responses from weaker ears, but
nevertheless give a useful identification of hearing impairment at peripheral level.
DPOAEs are particularly useful in adult clinical investigations and where higher
frequency information is required.

DPOAE grams may be superimposed on the patient’s TEOAE grams.  On terminating
a DP measurement, pressing T will return to the TEOAE measurement if previously
made.  In general, DPOAE and TEOAE levels are similar and recordings take similar
time, depending on the noise conditions.  The ratio of DP and TEOAEs has not yet
been explored.
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Sample OAE data

A number of pre-recorded samples are included with this software.  This can be
accessed from the TEOAE screen by pressing F7 and from the DPOAE screen by
pressing F3.  Explore the variety of OAE responses which can be obtained and
practice the manipulation of data by using the ILO facilities.

Real-time monitoring of TEOAEs

It is sometimes useful to quickly monitor acoustic conditions in the ear canal prior to
making a test.  From the main opening selection screen, select the Viewer box.  This
option requires working ILO hardware to be present.  The ear is given a standard
ILO88 click stimulus and if strong OAEs are present, they will be seen in real-time on
the upper window.  They can be copied for reference down to the lower window by
pressing S and reproducibility can therefore be confirmed.  While this is interesting for
training or demonstration purposes and can detect strong emissions, it lacks the
security systems necessary for diagnosis of hearing impairment and should never be
used for screening and clinical purposes.
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Version5 software installation

The installation software comprises four disks or one CD.  It may be installed under
DOS or Windows 95.  We do not recommend installation under Windows 3.1 as this
version of Windows has not proved a totally reliable means of operating the ILO high
performance data acquisition hardware.

Installation under DOS

1. Insert V5 installation diskette 1 into the A drive of your computer.

2. To start the installation process, from the C
prompt, type a:\install and press Enter.
Then follow steps 3-7 below.

Installation under Windows 95

1. Click on the Start button and select Run.

2. If you are installing from diskette, insert disk 1 in the A drive, type a:\install in the
window and press Enter, or click on OK.

If you are installing from CD, place the CD in your CD-ROM drive and click on the
Browse button.  Select your CD-ROM drive, followed by Install.

3. You will see an information screen describing the software version.  When you
have read this and if you agree to the conditions, press Enter.  Otherwise, press
ESC.

4. You will be able to select the disk drive on which the ILO software will be installed.
The sub-directory is automatically named.  To continue the installation, press Enter.
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5. A number of files will now be copied to your hard disk which will take a couple of
minutes.  If you are installing from diskette, insert disks 2, 3, 4 etc. when requested
and press Enter.

6. Installation is now completed.

In the case of a fully registered installation, when you start the program for the
first time, it will ask you to insert the Registration Disk provided with the software.
This will fully register the system.  The Configuration program will then be
automatically run.  You will probably be informed that automatic configuration is
necessary.  Accept this option by pressing the Enter key.  Automatic configuration
reads your registration file and sets the system configuration to look for and
recognise your particular ILO system.  It also enters the global site name which has
been issued to you into the system.  Configuration is also used to select the display
screen and printer you will be using.  After automatic configuration is complete, you
will see the screen below.

In the case of an provisionally registered installation of the program, when you
start the program for the first time you will be given the following options:

1. To load your registration file from a disk in drive A:
2. To enter your new registration details manually
3. To restore the previous registration stored in register.ilo
4. To continue using software and register later
5. To Exit the program now



1-24 ILO OAE Instrument User Manual Issue 5a : October 1997

When new registration details have been entered or loaded, the ILOCFG screen
will then be presented, as shown above.  If registration details are not loaded, an
option to load will be presented each time the ILOV5 program is run.

After registration and automatic configuration, the ILOCFG configuration program
can be recalled from within the ILOV5 program or externally by calling ILOCFG
from within the ILO-V5 directory.  The operation of ILOV5 can be customised using
this program.

6.1 Select G to identify the graphics display; select option 3 for standard VGA
graphics displays.  If your system normally runs in SVGA mode, you may
select option 5.  If problems arise with this option on your machine, revert to
option 3.  The remaining options are included for compatibility with older
software and will not normally be required.  Option 1 (CGA) provides
monochrome, low resolution graphics suitable for very old PCs.

6.2 When you have made your selection, you will be offered choices of screen
colors.  We recommend that you accept the standard option (0) and explore
the other options at your leisure once you have become familiar with the ILO
software.

Please note that the graphics choice becomes effective on starting the ILO
program.

6.3 The line H identifies the Otodynamics hardware you will be using.  If the
software has already been registered to you, then this will have been pre-
selected.  Please check the entry.

A list of hardware is shown below:

1-Card Identifies the ILO88 XP, ILO92

2-Card Identifies the original ILO88 system, comprising two full-length
expansion cards with desktop amplifier unit

E-Port Identifies the ILO88 and ILO288 parallel port interfaced products
(Echoports)

CODECi Identifies the internally mounted ILO systems - ILO88i, DPi, TEi
and 88DPi

1-88DP Identifies the ILO88 DP clinical desktop ILO system employing
one full-length expansion card

D-Port Identifies the ILO292 DP Echoport battery portable TEOAE and
DPOAE system
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1DPT96 Identifies the ILO96 research OAE system with DPT desktop
amplifier

NoCard This option will not search for ILO hardware but  will allow data to
be examined and simulated recordings made for training
purposes.  This is useful if running the ILO software on a second
computer for analysis purposes.

Other information about your registration is shown.  The Global Site Name is
incorporated in all data files and identifies your testing site.  The serial
number should be as marked on your ILO hardware.  If your system is not
working and the registration details do not match your installation, please
consult your dealer.

6.4 Check the printer type shown:

e.g. P printer PRT=MAIN_PRT.DRV;0;0;0

To ensure that the ILO is configured for your printer, select the P Printer
Type option.  You will see the Select Print Machine screen.  The properties
of the current printer driver will be shown.

To change the printer, use the up/down cursors to find your printer or a
related printer.  Press D to select this printer.  Select Standard print content
(0).  You will then be offered the Printer Port selection; enter 0 if you are
using the standard printer port.  The program will return to the opening
screen.

6.5 Check the level of function.  eg:

Level of Function (menu facilities) ..  LEV=ILO88-DUALCH

For ILO88 systems for use in the USA and for general screening purposes,
this should be set to Option 6 ILO88+SCREEN.  For clinical and research
systems, including DPOAEs, it should be set to LEV=ILO88-DUALCH.
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ILO88 and ILO288 Echoport systems will not provide DPOAE functions,
even if selected.

6.6 To exit, press Q followed by Enter.

6.7 The installation is now complete.  You may return to ILOCFG at any time to
make changes to the installation.

7. There are a number of other options available on this screen which you do not
need to change until you begin to use the system.  You can run the program
ILOCFG at any time from within the ILOV5 program.  The options available are
listed below.

7.1 R  Raw data spooling directory.  This identifies the directory where raw
data from a test may be saved.  If left blank, raw data will be saved on
ECHOSPOO, with the file extension .MEG.  See Customise for how to
enable raw data recording.

7.2 D  Data Directory.  This sets the directory where standard ILO data files are
stored.  If left blank, the directory ECHODATA is used.

7.3 S  Stimulus Directory.  This determines the directory from which custom
stimuli are read.  If blank, the directory ECHOSTIM is used.  It is not usually
necessary to make an entry here.

7.4 E  Expert Interpretation Directory.  This defines the directory where
normative data profile are stored.  If blank, the directory ECHOSTAT is
used.  Refer to Use of the ILO Statistical Analyser.

7.5 I  Interpretation statistics filename.  Enter the name of the statistical
database file created by ILOSTATS for use with the OEG function of the
analysis menu.

7.6 M Macroprogram preload name.  Enter the name of the macro program
library file to be automatically loaded with the ILOV5.  Files beginning with
the letters AUTO will automatically result in program 1 being run (included
for compatibility with earlier versions).

7.7 A  Automatic Stop Protocol filename.  Enter the name of the protocol file
you wish to use to control the test.  The file may be created and edited
within the ILOV5 program.  A control is enabled using the Customise T
option and if no name is entered, the file MANUAL is used.

7.8 F  Function Level (menu facilities).  Controls the menu complexity and
options available.  Not every level can be used with all installations.
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7.9 L  Language options.  Selects the language used on the main menus.

7.10 N  Navigation options (mouse/keys).  We strongly recommend drop down
menu option, which requires a mouse.  The original ‘keystroke’ operation
mode of the ILO88 can be selected for compatibility with earlier versions.
The mouse can be used to navigate around the ILO program.  The
recommended mode is DROPDOWN MENUS.  The current mode is
indicated on the N Navigation Options line.  Selecting this option will allow
the choice of the original ILO88 hot key system (0), hot key control with the
choice of mouse operation (1) and mouse operation with dropdown menus
(2).  The ILO software recognises the computer mouse, if one is installed on
your PC.  Its use in controlling the ILO292 functions is optional.  The
software may be completely controlled using keystrokes.  These are
identified in the User Manual and also by operating Help keys on important
screens.  The DPOAE section of the program accepts both keystroke and
mouse operation, by default.  The TEOAE section of the program offers two
modes of operation, vis a vis the classic keystroke operated ILO88 mode or
the V5 dropdown menu mouse operated mode.  To change modes on the
TEOAE program, you need to call ILOCFG from the DOS prompt.

7.11 C This allows various switches to be set for customised options of the ILO.
Not all the options are available to all installations.  On selecting C, the
customising menu in seen.  Options of general use are as follows:

A Turns on or off the ILO beep sounds.

H Enables measurements up to 8kHz on certain systems only.  The
function must be additionally enabled in the set-up options of the
DP program.

I Performs a more rapid start-up by by-passing the opening
screens, if the software has been recently accessed.

L Activates the interface with compatible databases such as
Hi•Screen.  In addition, it is necessary to select ILO+DATABASE.
Access to HiScreen requires registration with NCHAM.

M Allows or inhibits mouse operation.

N Enables additional low frequency rejection during recording.  This
is useful when screening in noisy conditions.

O Automatically opens the ILO spool file which allows raw data from
a test to be saved.  This option requires substantial memory -
only use it if advanced statistical processing is required.
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P This controls the probe usage tracking system, which records the
workload of each probe for warranty and service purposes.
Currently, DP Echoport and TE, 88i and 88DPi systems are
capable of automatic probe identification.

X Works in conjunction with P and sets the time between reminders
to test the probe condition.

R This controls the automatic display of processed data during the
test.

S Allows the original ILO file naming protocol to be used if required.
The new protocol identifies the site in the name so that every test
record is globally unique.

T Enables automatic test termination according to the conditions
set out in the protocol file.  The specific file should be named at
the main ILO CFG screen, see A, Automatic Stop Protocol
filename.  The default protocol file MANUAL is used if no
selection is made.
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PART TWO
TEOAE User Manual



2-2 ILO OAE Instrument User Manual Issue 5a : October 1997

TEOAE functions of the
ILO Version 5 software

Running the ILO program
To run the program in DOS:

n Change directory by typing: cd\ilo-v5 or the alternative you have selected during
installation.

n Type ILOV5 to start the program.

To run the program from Windows 95:

n Double-click on the ILOOAE icon.

Windows will automatically open an MS-DOS application area which will close auto-
matically when the program is terminated.  Windows cut-and-paste utilities will not be
available.  You will be able to switch windows between the ILO and other programs,
but we strongly recommend you do not do this while the ILO is actually collecting data
as your computer may not have sufficient speed to service both applications.

An alternative way to run the ILO program from Windows 95 is to open an MS-DOS
application area by selecting the MS-DOS prompt option from the Program list after
pressing Start.  Once in the MS-DOS area, proceed as for running under DOS.

If the program fails to recognise the requested hardware, a message will be issued
(see Appendix 3: Error Messages).
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You will now be presented with your opening screen.  The center panel will indicate
the ILO hardware you have installed, as shown below:

If no hardware is recognised, the screen will default to the basic ILO88 format.  This is
quite normal if you are running the software on a second PC.  If the software fails to
recognise the hardware that you have installed, check that your hardware is correctly
identified in the ILOCFG program.

Press Enter and you will be presented with the Options screen; selecting Utilities will
show a second screen containing various set-up options.
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The options screen provides the following selections:

System Information:  Shows which products your release of the software can oper-
ate.  It also shows the registered serial number and the unique three-letter site identifi-
cation code allocated to your installation.

Help:  Provides the Otodynamics telephone number applicable to your area.

Name:  Allows entry of the patient’s details before selecting TEOAEs or DPOAEs
programs.  After entering the patient’s name, the current data directory may be
searched for previous matching records.

Data Files:  Provides a list and summary of TEOAE files.  If a file is selected, it is
temporarily loaded and displayed.  The display is cleared by pressing the Enter key.

Back Up:  Transfers files from the current TEOAE directory into the Back Up directory.
The option to clear the current directory is given after copying.

Stop Logic:  Selects the automatic test termination protocol for the TEOAE test.
Please see Menu section for details.

TEOAE:  Enters the ILO88 TEOAE program for data recording.

DPOAE:  Enters the ILO DP program for recording.

Viewer:  A utility for observing OAEs in real-time as a preview to full measurement.
The Viewer detects only strong OAEs.

Utilities:  This opens the second page of options.
Equipment: This runs the system test program.
Configure: Runs the ILOCFG program for customised options.
New-Reg: Reads a registration file from a floppy disk in drive A.  This may

be required as part of an upgrade.
Stop Logic: Provides a means of designing a test protocol file.
Exit: Returns to the main opening screen.

Restart:  Restarts the Version5 program so that option changes can become effective.

Exit:  Terminates Version5.
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Running the test program
We strongly recommend that the ILO test program is run immediately following installa-
tion, to check that the hardware is correctly installed and calibrated.

1. From the opening Options screen, select the Utilities box.

2. Double-click on the Equipment box, or press E on the highlighted Equipment box.

3. You will see the opening screen of the hardware specific test program matching the
hardware that you have installed.  Follow the instructions.

4. Select the Menu button and then User Diagnostics, followed by Functional test &
report.

The test is automatically performed on your hardware and the following report
screen is shown:
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This may take several minutes.  Each function of the equipment is listed and ticked
if correct.  If a cross is seen in any box, please obtain advice from your Otodynam-
ics distributor.  You may be asked to examine an error log file or run additional
tests.

On termination of the test program, you may have to restart the ILO program.

NB: The test program for the two-card ILO88 must be run from the DOS
prompt  using the call ILOTEST.

Opening up an OAE recording session
From the Options screen, select the TEOAE box.  This
will open up the ILO88 TEOAE screen.  Enter the
patient name, ear and case note identifier and then
press Enter.  The ILO will perform the acoustic probe fit
test called Checkfit.  A ‘click’ sound should be heard
from the OAE probe and the top left panel of the ILO
screen should register this click and other sounds
made by the patient.  To continue with the standard
test, press Enter.

The DPOAE program can be accessed from the Options screen or from the TEOAE
program by pressing D from the main display screen.

Mouse operation
The ILO software recognises the computer mouse, if one is installed on your PC.  Its
use in controlling the ILO292 functions is optional.  The software may be completely
controlled using keystrokes.  These are identified in the User Manual and also by
operating Help keys on important screens.  The TEOAE section of the program offers
two modes of operation, vis a vis the classic keystroke operated ILO88 mode or the V5
drop-down menu mouse operated mode.  The mode of operation can be selected
using the ILOCFG program - option Navigate.  You may select Option 0, Original
ILO88 Hot Key Menus, Option 1, Hot Key Menus or Mouse option, or Option 2,
Mouse & Drop down menus.  With Option 1, activate the mouse mode within the
TEOAE program by clicking on the Menu button with the mouse.  To revert to the
keystroke mode, select Toolbar off from the Options menu.
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Preparing for a TEOAE recording

Fig 1

Figure 1 shows the opening screen of the ILO88 TEOAE system.  Instructions are
shown at the bottom of the screen.  The cursor is set to receive the patient’s name
(maximum of 17 characters), followed by the Enter key.  The left or right ear can be
selected.  Pressing any key will change the ear from left to right, or vice versa.  Press
the Enter key when the selection is correct.  A hospital ID number or other information
can be entered into the Case field.  Entering a Case field is optional.  If no patient
name is entered, the test can proceed but a patient name will be asked for when the
data is saved to disk.  The date is automatically entered on completion of the Patient
Name panel (fig 2) and is saved along with the TEOAE recording.  It is important that
the computer date is correctly set before using the ILO88.

Start subsequent test
by selecting an option
from the Test menu
(right).

Fig 2
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The Checkfit panel appears on completion of the Patient Name panel and is shown in
fig 3.  This stage of the test is to assist with the correct fitting of the probe in the ear
and the setting of stimulus levels.

Fig 3 Fig 4

The Stimulus panel is active and shows the stimulus waveform being monitored in the
ear canal.  The panel gives real-time feedback so that the effect of adjustments to the
probe can be immediately seen.  If a click stimulus is being applied (this is the default
stimulus) then the stimulus waveform should be as short as possible and normally less
than 1ms in duration.  Occasionally, the characteristics of an ear canal will distort the
stimulus waveform - this is discussed further in the Advanced Testing Techniques
section.  This section also discusses the use of the Stimulus Spectrum panel (fig 4).

The Stimulus Confirmation Panel (fig 5) is seen below the Patient Name Panel.  The
purpose of this panel is to confirm the stimulus conditions.  The default setting is for a
non-linear stimulus of Name CLIKN for the standard (preset) TEOAE and DbleNL
RAPID for the Quickscreen option to be presented with 0dB gain.

Fig 5
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Fitting the OAE probe
A well fitted probe fulfils the following conditions:

(a) It seals the ear canal in order to convert the small movements of the eardrum into a
pressure fluctuation which can be detected by the probe microphone.

(b) It excludes external noise from interfering with the recording.

(c) It provides a suitable acoustic environment in which the probe loudspeaker can
generate the correct stimulus.

To achieve this, the probe must be fitted with a removable soft tip.  The size of this tip
must be selected after visually inspecting the patient’s ear canal size.  See the section
entitled Otodynamics Probes and Accessories : Identification for a review of probe
types and tips available.  Probe tips should be discarded after use.

If the tip is too small, it may allow noise to enter the ear canal or distort the stimulus
content.  If the tip is too large, the probe will not penetrate sufficiently into the ear
canal.  This may result in a small response and instability of the probe during the
recording.  It may also not be possible to exclude sufficient noise if the tip is too large.

The tip should be fully fitted onto the probe.  In the case of single round-hole tips,
ensure that it is pushed on fully so that its surface is level with the sound tubes.  Tips
which extend beyond the sound tubes can introduce oscillations of the stimulus
waveform.

When the probe is inserted into the ear, the end of the probe must not become
pressed against the ear canal wall as this will impede the delivery of the stimulus and/
or the recording of the OAE.  This situation is usually obvious from the waveform in the
stimulus panel.

The adult or child patient should be still, quiet and sitting comfortably.  Ideally, the
probe is pushed into the ear firmly so that it does not need to be held to stay in place.
It is usually helpful to extend the pinna slightly.  If this cannot be achieved, it is accept-
able for the patient to held the probe, once fitted.  The probe should not be fitted by the
patient.  By supporting the cable around the subject’s shoulders, noise and any drag
on the probe will be minimised.

To make TEOAE measurements on infants, the infant should be lying quietly.  In the
case of newborns, the ear canal can close as the probe is inserted.  To avoid this,
gently pull on the pinna towards the back of the head.  Inspect the ear canal to see
that it is open and, if so, insert the probe firmly.  At insertion, it is helpful to position the
probe so that the cable is directed towards the front.  After insertion, and while still
holding the pinna, rotate the probe so that the cable is directed 45 deg towards the top
of the head.  At this point, release the pinna.
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The ears of newborns are frequently wet or contain debris.  If a good stimulus and
recording are not achieved on first insertion, remove the tip, together with any material
it contains, and replace the probe after fitting a new tip.

Monitoring the probe fit quality
With the ILO88 in the Checkfit mode, the Stimulus panel displays the sound pressure
being delivered to the ear canal.  It is easy to detect common fitting problems using
this display.

Fig 6 shows an oscillatory stimulus waveform.  This is not ideal for TEOAE recording.
In an adult ear it can be caused by bad fitting or by an atypical ear canal shape.  In the
latter case, the stimulus waveform has to be accepted but refitting should always be
tried.  Fig 7 shows a good adult probe fitting.

Fig 6 Fig 7

In the case of newborns, some oscillation is always found.  Fig 8 shows an acceptable
degree of oscillation in a newborn.
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Fig 9 shows the effect of the probe coming too close to the ear canal wall or other
obstruction.  The characteristic of this condition is a slow, rounded, low frequency
wave following the initial sharp peaks.  The probe should be refitted if this is seen.

Fig 8 Fig 9

Fig 10 shows the effect of excessive noise on the stimulus waveform.  This may be
caused by a loose probe fit, allowing external noise to enter the ear canal, or by noises
made by the patient.  Patient noises are typically breathing, swallowing or teeth
grinding.  Some ILO instruments, e.g. the ILO292, include an audio monitor for tracing
the origin of excessive noise.

Fig 10



2-12 ILO OAE Instrument User Manual Issue 5a : October 1997

Monitoring the noise level
The ILO88 continuously monitors the level of noise being received by the microphone.
Excessive noise can be seen on the Stimulus Waveform panel.  Even small amounts
of noise can degrade the quality of OAE recordings.

Incoming noise is analysed on the Noise Control panel on the right-hand side of the
screen (fig11).  The lower section contains a dynamically updated indicator bar which
registers the instantaneous level of noise.  If the bar reaches the upper part of the
panel (marked NOISY) then conditions are unsuitable for making recordings.  Provided
the bar is not permanently at the top of the panel, it may be
possible to record strong OAEs, given sufficient recording
time.  However, we recommend that the source of noise is
traced and reduced.

Useful recordings can be made with the noise bar in the lower
two-thirds of the panel.  As the bar is updated, a record is left
of the noise levels that have been encountered, in the form of
a histogram.  This allows the operator to assess the propor-
tion of time when the patient/room is quiet.

The arrow indicates the maximum level of noise which is
accepted for recording.  This is adjustable by the operator.
The arrow can be moved up and down using the cursor keys.
The Reject Level is indicated in the upper panel in both the
dBspl and sound pressure (milliPascals).  If placed opposite to
the maximum of the noise histogram, then approximately 50%
of the sweeps will be accepted and 50% rejected.  This is a
suitable setting for medium levels of noise, i.e. 45-52dBspl pe
(coloured light green through orange).  For lower levels of
noise, the reject arrow can be set to include two-thirds or more
of the sweeps.  This region is coloured dark green.  If record-
ings are made in noisy conditions (red colour), the reject
arrow should be set so as to accept only the small percentage
of quiet sweeps.

As the test proceeds, the number of accepted (low noise)
sweeps is shown as N low and the number of rejected sweeps
as XN high.

When the probe fit and reject level are set, the Checkfit
process may be terminated by pressing the Enter key.
Additional facilities are available during the Checkfit process.

Fig 11
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Additional features of Checkfit
The Checkfit panel indicates additional facilities of use for optimising recording condi-
tions. These functions are called out on the Checkfit panel.

S
Pressing the S key will immediately stop the delivery of stimulus to the ear and
freeze the Checkfit display.  This is useful for example when a mistake has been
made in the fitting of the probe and the operator must attend to the patient.  With
newborns who are becoming restless the brief cessation of the stimulus click may
be helpful.  Any key pressed after S will cause a resumption of the stimulus and the
Checkfit process.

Space Bar
On pressing the space bar, an extended view of the sound waveform in the ear
canal is obtained in the Response Waveform panel.  This can be useful in identify-
ing the nature and source of noises which are interrupting the Checkfit process.

O
Pressing the O key provides an extended display of the ear canal sound waveform.
This serves as an oscilloscope and is useful for tracking down sources of interfer-
ing noise.  The oscilloscope function is often useful at installation time where it can
be used to identify interference of electrical origin from either the power supply or
radio interference.  Please consult your dealer if regular patterns of noise appear
on this display even with the probe fully blocked by the finger.  (The oscilloscope
display is terminated by pressing the O key a second time).

A
Pressing the A key will display the Auto Adjust Stimulus panel.  This panel is used
to normalise the stimulus peak level in the ear canal to the recommended level for
Transient OAE measurement (0.3 Pascals).  The precise stimulus level is not
critical for TEOAE measurements.  This function should be used with caution since
it is incorrect to adjust the stimulus to compensate for a bad probe fit.  First
optimise the probe fit using the default stimulus level and only after this is achieved
press the A key on the Auto Adjust Stimulus panel.  The stimulus gain will then be
automatically increased or decreased to fine tune the stimulus level to the recom-
mended value.  The ILO88 adult probe is designed to give an acceptable stimulus
in the average adult ear with the default stimulus gain settings.  Similarly, the
neonate probes are designed to give the correct stimulus level in the average
newborn ear.  When using these probes with adults or newborns respectively, it is
not normally necessary to adjust the stimulus level.  With infant or child ears the
Adjust function is useful since these patients have intermediate sized ear canals.
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Activation of the Auto Adjust key (A) leads to a termination of the Checkfit process
and the presentation of the Test Select Menu (see below).

G
Pressing the G (GO) key allows the default ILO88 TEOAE test to proceed immedi-
ately.

Enter
Pressing the Enter key calls up the Test Option Select menu from which different
stimulus patterns may be selected.  The Checkfit process is always conducted with
the standard click stimulus as the wide frequency band nature of this stimulus
allows all aspects of ear canal and probe fitting characteristics to be displayed.

Cursors
The function of the UP/DOWN cursor keys has already been discussed.  These are
used to manually adjust the level at which noisy sweeps are rejected in the signal
averaging process.  The LEFT/RIGHT cursor keys have a specialised use in that
they change the window over which noise reject assessment is made.  Normally
this should be as wide as possible and is preset to begin at 3.8ms from the stimu-
lus.  This setting usually succeeds in excluding any stimulus artefacts which may
be of substantial level.  In the case of other stimuli being used (e.g. Toneburst) or
of an ear canal which cannot be optimally fitted and suffers from a recognisable
stimulus artefact invasion into the response period then the LEFT/RIGHT cursor
keys may be used to exclude this initial corrupted period from the noise response
analysis.  The new setting of the Reject Time Window can be made permanent for
the session by pressing the INSERT key after adjustment.  Please see the ad-
vanced usage section for further information.

Esc (Escape)
Pressing the ESCAPE key during the Checkfit process immediately terminates the
Checkfit.

F1
Pressing the F1 key calls up Help information on the Checkfit process.
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Managing a TEOAE recording

To start a test, pull down the Test menu, select TE fullmenu for
the full selection of TEOAE tests, or choose QUICK TEOAE,
TonePip TEs or Spontaneous options.  The Checkfit will com-
mence, as described in the previous section.

After the Checkfit process, the Tests selection menu appears if
you took the full TE fullmenu option.  Otherwise, the preselected
test will commence automatically.

The pre-set TEOAE recording mode is the original ILO88 mode
which uses click stimuli arranged in a pattern to detect non-linear
OAEs.   Recording of TEOAEs commences immediately on termination of the Checkfit
process with the ‘G’ (GO) key.  If the Enter key is used to terminate the Checkfit
process then a Test Option Selection menu is presented.  Pressing the Enter key will
select the pre-set TEOAE mode and the test will commence immediately.  For informa-
tion on the alternative stimulation modes please see Advanced Usage of the ILO88.

When the TEOAE test begins the Collecting Data menu is
shown.  The second line shows the selected option (default is
‘pre-set’).  The operator is provided with various facilities to
assist in the optimisation of the TEOAE recording.  These are
as follows.

End [Enter]
The Enter key terminates the collection process.  A single
press will result in termination when the number of quiet
sweeps collected reaches the next multiple of 10.  This is
recommended for normal termination.  In the case that there is excessive noise and
termination is not occurring due to rejects, then a second press of the Enter key will
result in immediate termination of the collecting process.

Interpret
Pressing the I key interprets the data collected so far as a complete recording and
displays this information graphically.  This is useful in deciding whether the test
should be manually terminated at any time.
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Half Octaves
The H key function also interprets the data collected so far but differs from the I key
function in that a half octave frequency analysis is displayed.  This can be useful in
detecting significant OAE responses in restricted frequency bands.  This is nor-
mally useful when recording in less than optimal noisy conditions.  The I key can be
used after the H key to change the display back to the more common waveform
display.

Waveform
The W key restores the normal waveform display monitoring.

Statistics
This displays a statistical analysis of the evidence for OAEs in frequency bands.
Refer to the Analysis menu, Statistics.

Pause [Esc]
Pressing the Escape key pauses the data recording and provides options to go
back to Checkfit (press C) or in advanced usage of the machine to compare the
current fitting of the probe with the previous fitting (the R key).  For information on
the advanced use of the ‘Retry Probe Fit Comparison’ screen please see Advanced
User Information.  Briefly this function allows the probe fit to be monitored with
great accuracy so that it may be returned to a previous position or the effect of
different positions may be examined, for example during the training process.

Cursors
The UP and DOWN cursors change the Noise Reject level as described above.
This is frequently used during a test to accommodate the range of noise presented
by the subject.

The LEFT/RIGHT cursors change the window over which noise assessment is
made.  It is not normally necessary to adjust this.

Oscilloscope
The O key provides a real-time oscilloscope display of the current waveform in the
ear canal.  This can be useful in identifying the source and nature of interfering
noise as described above.  When using the live input display during the collecting
process the UP and DOWN cursor keys can be used to change the viewing scale
so that the nature of both very large and very small sound waveforms can be
examined.  Recording continues during the oscilloscope display.  The display may
be terminated by pressing the O key a second time.  The oscilloscope function is
not normally part of routine recording.   It is useful when setting up the system,
when training new operators and when investigating interfering noise.  No clinically
significant observations can be made from using the oscilloscope display.



Issue 5a : October 1997 ILO OAE Instrument User Manual 2-17

Space bar
Pressing the space bar of the keyboard will briefly display the current waveform
held in the signal accumulating memory.  This waveform naturally grows as the test
progresses and can be useful to provide an early indication of excessive noise or
good response.

In addition to the monitoring of normal noise levels in the right hand noise panel the
ILO88 detects the occurrence of excessive noise and flashes a warning (OVERLOAD-
ING check fitting and stimulus waveform) across the screen and sounds an audible
warning of overload.  (The occurrence of excessive noise can easily be due to the
patient making a noise e.g. speaking or crying).  Recording does not continue during
excessive noise.  This facility also acts as a warning if stimulation greater than 94dB is
inadvertently applied to the ear.  In the event of repeated overload conditions the test
will automatically stop and the stimulus will be disconnected from the probe.  This acts
as a safety device.

The stimulus is continually monitored during the recording.  The ILO88 performs brief
Checkfit tests at intervals and refreshes the Stimulus Waveform display.  This is useful
to detect probe slippage.  If the probe fit changes substantially, the filled circle in the
stimulus panel changes to a hatched circle.  If the change becomes major, an X is
seen in place of the circle.  Colour changes are also visible on a colour VDU.

After termination of the collection process the data is immediately analysed and
displayed graphically on the screen.

Assessment of response during recording
Using the options above from the Collecting Data menu, the response can be as-
sessed during the recording.  Whenever the Interpret key is pressed all the panels are
updated.  This process happens automatically if the Refresh Rate is set to be greater
than zero (Settings menu) or if Automatic Termination is set using the Stop Logic
Protocol.

An additional panel is introduced onto the display at this time if the Band Set option is
checked.  The panel shows a measure of the statistical validity of the data in each
frequency band based on the reproducibility of the data collected so far.  This offers a
reliable method for assessing the quality of the recording and the presence or other-
wise of emissions which exceed the current level of background noise.
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Alternative TEOAE stimuli
The ILO88 default stimulus is a click which has a broad fre-
quency spectrum useful for evoking responses from the cochlea
between 500 and 6,000kHz.  The default sound delivered by the
adult probe in the average ear results in a 0.3 Pascal peak
stimulus (84dBspl pe).  The stimulus is repeated at intervals of
20ms which allows enough time for acoustic emission for OAE
responses to be returned from the furthest part of the cochlea
(the apex).  Such a long time interval is not necessary if re-
sponse frequencies below 1kHz are not required.  In newborn
screening applications it is not normally useful to collect informa-
tion below 1kHz (a) because the probe fit and the
acoustic characteristics of the newborn ear canal result in
an attenuation of these frequencies and (b) because the
typical noise present during newborn screening is of low
frequency and generally masks the appearance of OAEs
below 1 kHz.  If it is appropriate to miss the very lowest
frequency OAE response then the stimulus rate may
usefully be increased.  This is provided for in the Quick-
screen stimulus option.

The Quickscreen TEOAE stimulus utilises a repetition
rate of 80Hz (12.5ms between stimuli).  The increase in
rate over the standard stimulus provides increased speed of data recovery.  Further-
more, there is increase in data quality at high frequencies which normally emerge from
the ear within the first 10ms.  This is due to the removal of noise without signal which
occurs at the end of the standard OAE sweep.  (The same enhancement can be
obtained by retrospectively windowing the first 10ms of the response as described in
Advanced User Information.  The advantage of the increased rate cannot be restored
after the recording is finished).  In addition to the increased stimulus rate, the Quick-
screen stimulus has a slight redistribution of total stimulus energy to give a small boost
(3-4dB) in the 2-3kHz region and a corresponding decrease in the energy provided at
frequencies below 1kHz which are not useful at this stimulus rate.  The Quickscreen
stimulus was designed to achieve optimum results in newborn screening and was
validated in trials at the Rhode Island Hearing Assessment Project at Women & Infants
Hospital, Providence.  Although designed for newborn screening, the test may be
applied to adults’ ears and can often succeed in identifying significant activity above
4kHz when this is not visible with the default mode due to noise.

One advantage of the TEOAE recording method using clicks is that all accessible parts
of the cochlear response are tested simultaneously.  Frequency analysis of the OAE
after the recording allows responses at individual frequencies to be identified.  How-
ever, it is sometimes necessary to restrict the stimulus band width and this is achieved
by replacing the click stimulus with a short Toneburst.  Obviously in the case of a
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toneburst stimulus responses can only be recorded within the band frequencies
provided by the stimulus.  However there are two advantages in making this change:

(a) The TEOAE test can be conducted at a specific band of frequencies to match data
available from electrical evoked responses on the same patient.  The ILO provides
facilities for tailoring the Toneburst stimulus to match that available on ABR
diagnostic instrumentation.

(b) If no response is obtained in a significant frequency range using the click stimula-
tion method then Toneburst stimulation at the frequency of missing OAEs can be
used to confirm their absence.  Delivery of a Toneburst stimulus at the same peak
level as the click stimulus (0.3 ta) maximally stimulates the relevant region of the
cochlea providing the maximum chance of observing any OAE response present.

The Toneburst stimulus option is available on terminating the Checkfit process.  On
selecting the Toneburst option the centre frequency of the Toneburst must be entered
and the test proceeds normally.  The final result displays the limited region of stimula-
tion and the Toneburst stimulus waveform so the interpreter is in do doubt that
Toneburst stimulus has been used.  If it is required to match the Toneburst profile with
that of other equipment used in diagnostic evoked response measurements, this is
available at the stimulus wave menu item.  It is not normally necessary to change the
Toneburst stimulus wave envelope and this should be undertaken only by persons
familiar with the significance of stimulus signal characteristics.  The ILO88 contains
controls which inhibit the use of stimuli which may lead to misleading or artefactual
results.

The Test Stimulus selection panel provides the opportunity to select both linear and
non-linear click stimuli.  Non-linear stimulation presents a balanced set of stimuli of
both positive and negative polarity which automatically cancels proportional acoustical
responses such as are obtained from the middle ear system in the early portion of the
sweep.  The use of non-linear stimulation provides a robust TEOAE test which rarely
contains stimulus artefact signals.  A disadvantage of this method is that a proportion
of the genuine TEOAE is also rejected, resulting in a reduction in signal-to -noise
quality and a corresponding decrease in test specificity.  The experienced user may
select linear stimulation to obtain a higher signal quality and greater specificity.
Considerable caution is needed however, since the operator must now visually
recognise the appearance of any stimulus artefact in the earlier part of trace.  This is
quite characteristic and consists of an oscillatory signal dying away rapidly in the first
3-6ms of sweep.  OAEs present will extend beyond this interval and across the screen.
Examination of the linearly derived TEOAE can be useful in confirming otherwise
uncertain evidence of OAEs by experienced users.  The method is considered to be
safe when used with stimulus levels around 10dB below the default level.  The data
should be disregarded when the Checkfit stimulus waveform exhibits a long oscillatory
form.
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Response validation
The ILO88 incorporates a number of features to ensure that your artefacts are ex-
cluded from the recorded data.  These features include the noise reject system, the
low frequency cut filter, the data window, which excludes stimulus oscillations from the
response and the non-linear detection system.

The ILO non-linear detection system relies upon a special stimulus pattern consisting
of three positive-going clicks, followed by one negative-going click of three times the
intensity.  The response to each of the four clicks is added into memory.  As a result,
any response component which is accurately proportional to the size of a click stimulus
becomes cancelled.  This includes most of the stimulus signal and the response of the
middle ear system, which are thereby eliminated from the recording.  A proportion of
the OAE response is also eliminated.  This sacrifice of signal quality is considered
worthwhile, particularly when recording from adult ear canals, which can create
oscillatory stimulus responses which otherwise might be confused with an OAE.  The
experienced user may select the linear stimulus option to record the whole OAE signal,
but must exercise caution not to accept responses of low latency which may be caused
by extended oscillation of the stimulus in the ear canal.  This is particularly important
when the Checkfit process shows an unsatisfactory probe fitting or when higher
stimulation levels are used.

A number of other possibilities exist for artefactual signals to be present in the final
response, although this is rare.  If a very low number of sweeps are used, it is possible
for background noise to pose as an OAE.  This is due to the variable statistics of short
noise samples.  For this reason, sweep numbers less than 60 are not recommended.
If data can only be recorded in shorter sections, these should be compared to ensure
that the suspected OAE signal is reproduced on all recordings.

Background noise may have tonal characteristics which prove more difficult to elimi-
nate by signal averaging.  It is possible for the tonal noise to be partially synchronised
by chance to the ILO instrument.  When this occurs, a regular oscillation can be added
to the OAE response and a corresponding peak can appear in the OAE spectrum.  If
accidental synchronisation occurs, the tonal interference noise can appear as a
validated blue peak.  Characteristically, it will appear red on the subsequent record-
ings.  We recommend the following procedures to guard against this form of artefact.

Firstly, the noise present in the test room should be regularly analysed.  This can be
achieved by making an OAE recording with the probe open to the room.  If the noise
level prevents this recording, then it is too high and must be reduced by acoustic
treatment.  When a test is possible, the oscilloscope option during the Checkfit process
should be used to examine the waveform of the room noise.  Periodic patterns gener-
ally indicate electrical interference, which needs to be eliminated by proper grounding
of the instrumentation.  The acoustic noise in the room will also be seen.  Acoustic
noise may be distinguished from electrical noise by blocking the probe firmly with the
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finger.  This should eliminate all acoustic noise.  When the full TEOAE test is com-
pleted with the open probe, the presence of high peaks in the noise spectrum will
become evident.  Acoustic treatment is necessary to eliminate these.

Occasionally, infant ears can contain their own continuous tonal background interfer-
ence.  These are known as spontaneous otoacoustic emissions.  They can exceed the
size of stimulated OAEs.  They are visible as sharp peaks on the OAE response
spectrum and as a uniform oscillation right across the Response Waveform panel.
Spontaneous OAEs can therefore appear to be acoustic interference.  To distinguish
between SOAEs and acoustic interference, the SOAE Check option should be se-
lected.  This repeats the TEOAE measurement with a reduced click stimulus and
registers only OAEs which are sustained for long periods after stimulation (the click
rate is reduced by a factor of four and data is recorded from 20 to 80ms post stimulus
time).  Since spontaneous OAEs are readily synchronised with this stimulus and
external interference is not, true spontaneous OAEs can be recognised by the instru-
ment and be distinguished from noise.  The normal waveform response panel is filled
with a noise analysis panel showing the spectrums of true noise and true SOAEs
respectively.  The latter are coloured blue.  TEOAE data can be accepted if SOAEs are
confirmed as the cause of the unusual waveform and spectrum.

System checks
A special test program is provided for thorough checking of all parts of the electronic
system used for OAE recording.  Use of this is described in the installation section.  It
is, however, useful to be able to check the proper operation of the system when in use
and this is provided by the Probe Check option.  The Probe Check option, which is
available after completing a Checkfit process, is intended for use with the test cavity
provided with the ILO system.  The probe is inserted in the test cavity and its correct
fitment is monitored during the Checkfit process.  When the Probe Check option is
selected, a synthesised OAE signal is delivered to the cavity via the probe loudspeaker
and collected by the probe microphone.  If all is correct, a recognisably artificial OAE
response is obtained, consisting of three Tonebursts distributed across the screen.
This test is used to check every Otodynamics probe before despatch and a printout of
the response is provided with each probe.  If the test OAE is not obtained, the system
must be considered as defective.  If the pattern obtained is markedly different from that
delivered with the probe, then a deterioration of the probe response must be sus-
pected.  In the case of suspected system failure, the Otodynamics test program should
be run on the instrument.  In the case of suspected probe deterioration, the probe
should be visually examined and cleaned to remove debris and re-tested.  The probe
must be disconnected from the system before cleaning or servicing; see the instruc-
tions supplied with system and probe.
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Instrument calibration
The operator of ILO equipment should be familiar with the instrumentation test pro-
gram.  Details of this are shown in the installation booklet for your hardware.

There is a Probe Test option on the ILO menus, which allows the current probe to be
evaluated, assuming that the instrumentation is working normally.

There follow instructions for performing a calibration of the ILO system.

The test program should first be run and, if completed satisfactorily, this confirms that
the internal circuit is working correctly.  This test automatically confirms that the correct
amplification is present in each section of the system.

The test program does not perform tests on the OAE probe.  This is performed using
the ILO88 OAE measurement program.

Probe condition
The probe to be tested is fitted into the probe socket and the TEOAE program started.
The probe is fitted into the 1cc acoustic calibration cavity.  A Checkfit can be per-
formed at this stage as if beginning a patient measurement.  On closing the Checkfit
process, select the Probe test option from the Collection menu.  Confirm the type of
probe being tested and continue with the test.  The probe test injects an artificial OAE
which is recorded on the screen as a series of three oscillatory tone bursts at 700,
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2,000 and 4,000 Hz respectively.  A typical probe response is shown below:

A copy of the probe test performed at the time of manufacture accompanies every
probe.  We recommend that you perform and print a probe test on your equipment on
first receiving the probe and retain this for later comparison.  Substantial changes
(>3dB) on any tone burst may indicate contamination of the sound tubes, deterioration
of the probe transducers or incorrect fitting into the test cavity.  If, on cleaning the
probe and properly fitting it into the cavity, substantial deterioration of performance is
seen, the probe should be replaced.  Contamination typically reduces the higher
frequencies first, loose coupling to the test cavity can reduce the low frequency
response and may artificially enhance the middle frequency response.

While the above test is useful, it is unable to distinguish between changes in the
performance of the microphone and the loudspeaker.  An independent external
calibration should be performed at least annually when your ILO292 DP Echoport is
serviced, or at any time.

Two methods are provided for externally validated calibration of the ILO sensitivity - a
quick check and a detailed check.  In both cases, the DP Echoport itself is used as a
sound analyser and known sounds are presented to the instrument via the acoustic
probe.

In the quick method, the probe should be placed in a known sound field of 84dBspl
(0.1N/m2) at 1kHz.  Such a field may be obtained from a hearing aid test system or,
alternatively, with the use of a freefield audiometer.  In the latter case, a sound level
meter is needed to set the sound field to 84dBspl.  This should be set with the OAE
probe already in position next to the sound level meter microphone.  Care should be
taken that no movement of personnel in the room occurs during the subsequent
measurement.
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With the external sound field applied, and with the software performing the Checkfit
process, the stimulus window should show a sine wave peaking at +/- 0.33Pa.  This
level is marked by check marks on the side of the stimulus window box.  Production
tolerance allows for a +/- 2dB variation in probe performance which equates to a +/-
20% deviation from the calibration marks.  If absolute calibration of OAE levels are
required, a small correction can be computed from the actual level shown in the
stimulus window.  It should be noted that the microphone sensitivity may change with
frequency and it may be required to repeat this test at higher frequencies.

For a thorough analysis of the ILO acoustic sensitivity through any probe, the detailed
calibration options should be selected.  With this option, the ILO screen shows a
spectrum analyser display which records all sounds presented to the probe.  The
provision of an external sinusoidal tone will result in a peak appearing at the appropri-
ate frequency on the ILO screen.  The nominal intensity of the sound according to the
present calibration will appear above the peak detected.  On pressing the space bar,
the user is able to enter the true sound pressure level as indicated by their own
acoustic instrumentation.  On pressing Enter, this value is saved in a file against the
identity of that particular probe.  A series of frequencies can then be applied and the
calibration entered and this data will then be recorded for later use.  It is recommended
that at least one point of calibration is made for every third of an octave of frequency,
or a greater number of points if possible.  The dead file can be accessed whenever
that particular probe is re-inserted into the instrument and absolute calibration of the
acoustic measurements made by applying a correction.

NB: This detailed procedure is effective only when used with a probe which has
integral electronic ID.  The accuracy of this process is limited to the accuracy of
the acoustic measurement of the sound field supplied to the probe.  The use of
the ILO system for clinical screening purposes is not critically dependent upon
the absolute calibration of the instrument.  This is a screening device used to
detect rather than to measure cochlear activity.  For research purposes, the
above procedure may be important.  For general screening use, the quick test
will be sufficient to ensure that correct screening results are obtained from the
ILO system.

Back up
When the ILO TEOAE system is making recordings, it keeps a list of new recordings in
a separate file, called ‘TESTED.TXT’.  Also, when data is manually scored, it keeps a
list of scored data in the file ‘SCORED.TXT’.  The Back Up option allows data which
has been scored, or data which is being newly taken, to be copied onto the Back Up
directory, which the user may select.  After backing-up the data, the user is given
options to clear the list of new or scored data.  The user is also given an option to
delete the original copies of data, once they have been backed up.
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Fig 12
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How to read the ILO response screen

Screen contents
Fig 12 shows the result from a typical healthy adult ear.  Fig 13 shows a typical result
from a healthy newborn ear.  Both recordings were made with the default ILO88
settings.
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Healthy adult ear
The Stimulus panel (A) shows a short, biphasic click stimulus of duration 1ms.  The
Stimulus Spectrum (B) shows a smooth distribution across frequency (the decrease
towards 6kHz is a result of eardrum reflection - see advanced usage section).  The
stimulus has a peak level of 84dBspl, shown on Stimulus Analysis panel C, which also
provides a figure for the stability of the stimulus peak level during the recording.  The
inset graph in the Stimulus Analysis panel shows the stability of the probe fit during the
test.  A large-scale graph is available on pressing P or on selecting the Analysis menu
item Progress.  The figure given here of 63% indicates that the peak stimulus
changed by 37% during the test, probably because the probe slipped towards the end
of the test.  This could be examined by using the Progress Analysis in the Analysis
menu.  A useful result may still be obtained with probe movement, provided the
recording is stopped immediately (see stimulus stability indicator in the recording
section).  Panel D confirms that the stimulus was non-linear and of type CLIKN.  No
adjustment to the default gain had been made and this remains at 0.0dB.

The upper right-hand Noise Analysis panel (E) displays the conditions during the test.
The NOISE INPUT was 34.2dBspl and this refers to the mean level of noise in the ear
canal responsible for the residual contamination by noise in the final stimulus.  The
residual contamination in the OAE response is shown by the entry A-B DIFF 8.3dBspl,
which is the noise level present after the averaging process.  Sweeps with noise
greater than the selected reject level were rejected from the averaging process.  The
rejection level was set at 46.7dBspl (4.3mPa) for this recording.  In this recording, 376
noisy sweeps were rejected (NOISY XN 376) and only 48 sweeps were accepted.  The
total recording (F), (TEST TIME) took 1 minute 27 seconds.  Clearly, the subject was
noisy during this recording, but the ILO program was effective in rejecting the noisy
samples and the result  was a clear indication of OAE activity from 2 to 4kHz.  The
response at 1kHz was partially obscured by noise, but nevertheless was present.

The Response Waveform panel (G) shows the OAE waveform over a 20ms period.
Note that the earlier waves, 3-9ms, are more closely spaced (of higher frequency) than
the later waves, around 15ms.  This is quite typical but not seen in every case.  The
intensity of the response is shown in the Response Analysis panel (H) and is 15.5dB-
spl.  This contrasts with the noise contamination figure of 8.3dBspl (see above).  The
overall signal-to-noise ratio of this measurement is therefore 15.5 - 8.2 = 7.3dB.

It is important to note that the absolute response level (15.5dB) relates to the energy of
the OAE, whereas the signal-to-noise ratio (7.3dB) relates to the quality of the final
measurement.  The latter quantity can be improved by a longer recording, or lower
noise levels, whereas the former quantity is set by the characteristics of the ear.

Noise contamination in the final result causes a reduction in reproducibility.  This is
automatically tested in the ILO88.  During the recording, two independent collections
are made using alternate pairs of stimuli.  The Response Waveform panel (G) actually
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contains two superimposed OAE waveforms.  The differences are very small in this
example, but can be seen around 15ms.  The reproducibility is derived from the
correlation between the two overlaid waveforms and this is indicated in the Response
Analysis panel (H) by WAVE REPRO 84%.  A perfect recording would have a repro-
ducibility of 100%.  A 50% reproducibility would indicate that one half of the visible
signal consists of noise contamination.  There is no fixed criteria for rejecting a re-
sponse solely on the reproducibility figure.  However, a high value is always advanta-
geous.  An experienced operator can use the analysis facilities of the ILO to confirm
OAE responses which have an overall reproducibility of less than 50% - refer to the
advanced user guide.  The inset graph in the Response Analysis panel shows the
increase in reproducibility during the test.  Normally, this grows consistently throughout
the test.  A large-scale graph is available on pressing P or on selecting the Analysis
menu item Progress.

A more useful measure of the quality of a recording is obtained after the response is
broken down into its component frequencies.  Panel I shows the Response Frequency
Analysis, from 0 to 6.3kHz.  The hatched region shows the frequency components of
the residual noise.  This appears red in the colour display.  The unshaded area
represents the valid response, which should exceed the noise contamination.  The
shape of this detailed frequency analysis is often quite irregular, sharp peaks and
notches being very common.  To assist in the interpretation of this information, a
numerical summary is provided in the Response Analysis panel (H).  The reproducibil-
ity is shown as a percentage, five equal frequency bands centred on 1,2,3,4,5kHz
respectively.  Below this is shown the related signal-to-noise ratio in each band.  A
signal-to-noise ratio of =/>+3dB or a reproducibility >65% is normally significant in any
frequency band.  It is recommended that a significant OAE response in at least two
bands is obtained before considering the ear to have passed a test.  The Response
Waveform panel (D) contains the text Preset, indicating that the test conducted was
the default test for the ILO88.  The most common choice for newborn screening is
QuickScreen; this would appear in the response panel.  If the test is conducted under
an automatic stop protocol, the reason for test termination isalso shown in the re-
sponse panel, e.g. !”GoodSNR”.  This would indicate that the recording was automati-
cally terminated according to the protocol selected by the operator and refer to the
presence of the required number of frequency bands having a signal-to-noise ratio
considered to be passable.  The frequency band analysis is supplemented by other
functions, discussed later, which are the Half-Octave Analysis and the Spectrum
Cursor.

The final panel on this display, J, shows information about the filing of this data and of
the capacity for additional recordings to be saved.  The panel also shows the current
directories for saving data and for recalling data for review.  These may differ.
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Healthy newborn ear
Fig 13 shows results obtained from a healthy newborn ear recording in typical office
conditions.

Fig 13

There are a number of differences between this result and the result of the adult test.
The Stimulus Waveform panel shows that the stimullus is more oscillatory and its
magnitude, 76dB, falls significantly below the 84dB peak target of the ILO88.  This is
acceptable if a strong emission is obtained, as in this case.  The Stimulus Confirmation
panel confirms that no readjustment has been made to normalise the stimulus.  Even
so, the response obtained is very large (27.5dBspl).  This high level of OAE is common
in healthy newborn ears which are dry and clean.  In addition to the differences in
stimulation and response, the Noise Analysis panel indicates differences in the
recording conditions.  The noise input was 36.4dB and the noise reject was set higher,
at 46.2dB.  110 noisy sweeps were rejected, i.e. approximately half of the total.  As a
result, the newborn test took longer - 42 seconds.  Despite this, a very high wave
reproducibility was obtained (99%). This can be attributed to the high strength of the
OAE.  High reproducibility is shown in each of the five frequency bands.  The stimulus
stability was good at 95%, but not as high as obtained from the adult.
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Fig 14 shows a recording from the same newborn using the Quickscreen stimulus.
The overall result is very similar.  The stimulus is greater by 3dB as a result of the
redistribution of stimulus energy in the middle frequencies.  The noise contamination is
3dB less.  The response intensity is 5dB less, but this is the result of a normalisation
process which takes into account the uncollected response between 12.5 and 20ms.  It
is clear that the peak OAE intensity is almost identical in both recordings and the
frequency spectrum is also very similar.  The significant difference between the two
recordings is the reduction in time with the Quickscreen stimulus (26 compared to 42
seconds) for a similar quality of recording.  The advantages of Quickscreen become
more significant when recording weaker responses (see below).

As will be seen, the Quickscreen display includes an additional panel (K).  This
composite graph shows the stimulus, reproducible response and noise contamination
frequency spectra and their relative magnitudes.  This replaces panels I and B of the
standard display.  In place of I, the Quickscreen display panel L shows the response
signal-to-noise ratio as a function of frequency.  Note also that the centre frequencies
of the bands used in the Response Analysis panel differ from the standard response
values.  This is a consequence of the more rapid stimulus rate.  Improved frequency
band analysis is provided by the Half-Octave Analysis function.

Fig 14
K
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Interpreting weaker OAE responses
Fig 15 shows a response from a mature adult ear.  The OAE response intensity is
smaller than the first adult ear shown and the noise contamination is higher.  The
waveform reproducibility is 74% overall but the frequency band analysis shows that
OAEs are present in four bands at or above the 3dB signal-to-noise level between 1
and 4kHz.  This can be considered to be a satisfactory pass since the number of
sweeps taken (237) is adequate and the overall noise level is low.  Higher signal-to-
noise levels are often demanded when screen neonates under noisy conditions.
Higher values would also be necessary to pass an ear with fewer sweeps comprising
the result.

Fig 15
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Fig 16 shows the result of a recording in an adult ear with very small OAEs.  The
hearing is within normal limits.  Examination of the Stimulus and Noise Analysis panels
show that the recording has been correctly made.  The noise contamination of 0.8dB-
spl is satisfactory, as is the total number of sweeps recorded, 260.  However, the total
response intensity is less than the noise level of 0.8dBspl and therefore is not indi-
cated.  The reproducibility of the response is only 38%, which is unsatisfactory.

Fig 16

Careful examination of the response waveform shows a possible response in the 4-
6ms period.  This is also visible in the Response Frequency Analysis panel at 3-4kHz.
The 3kHz band in the Response Analysis panel indicates a 69% reproducibility and a
+3dB signal-to-noise level.  The limited response at 3kHz must be regarded as signifi-
cant from a physiological point of view but inadequate from a clinical viewpoint be-
cause evidence of cochlear function is present only over a very restricted range of
frequencies.

It is sometimes necessary to further validate such marginal responses.  This may be
achieved by repeating the standard measurement.  Alternatively, the Quickscreen
option may be used to enhance the signal-to-noise.
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Fig 17 shows the same ear, examined using the Quickscreen option.  The marginal
OAE is now clearly recorded with a level of -1.8dBspl.  The reproducibility is 73%
overall and achieves a reproducibility in excess of 65% in the 1.5, 2.2, 3.0 and 3.7kHz
bands.  This test provides confirmation of cochlear function across the whole middle
frequency band.  The small intensity of the OAE puts this response below average.
The clinical significance of this would depend on the purpose of the measurement.  For
mature adult ears, this type of result normally indicates a subclinical decrease in
cochlear activity, as would occur in early presbyacusis or noise induced hearing loss.
This example illustrates the value of the Quickscreen option in clarifying cochlear
status in marginal cases.

Fig 17

Fig 18 shows standard results from an adult ear with an average hearing loss of 20dB.
The OAE is not visible.  Application of the Quickscreen option, Fig 19, shows a
marginal OAE at around 4kHz.  This ear fails the OAE test.
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Fig 18

Fig 19
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Finally, Fig 20 shows a recording made using the Quickscreen option with the probe
inserted in the test cavity provided by Otodynamics.  No OAE is visible, as would be
expected.  Recordings should be routinely made in the test cavity to confirm that the
equipment is operating normally and does not produce artefactual responses.  This
example contains a small artefactual response confined to frequencies below 500Hz.
It is caused by the retention of unusual amounts of low frequency by the hard-walled
nature and the firm rubber seal of the test cavity.  This small low frequency artefact can
be tolerated because OAE signals below 500Hz are not recorded by the ILO88.  Also,
low frequency artefacts appear at the early part of the trace and low frequency OAEs,
if present, appear towards the end of the trace.

Fig 20
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Data analysis utilities

Use of the octave based OAE analyser
At any time when OAE data is displayed on the screen, an octave based analysis can
be obtained by pressing H or the Half-Octave item on the Analysis menu.  This will
produce a display similar to that shown in Fig 21.  The initial display shows the OAE
and noise level divided into half-octave frequency bands matching the frequencies
used in audiometry.  Narrower bands and higher resolution can be obtained by
pressing the keys 3 through 6 after the display appears, to give one-third, one-quarter,
one-fifth and one-sixth octave displays respectively.  A one-octave analysis is also
available.

Fig 21



2-36 ILO OAE Instrument User Manual Issue 5a : October 1997

From this display, a reliable assessment of cochlear status can be made.  The analysis
groups together all response components and noise contamination in the stated
frequency band and displays these simultaneously so that both the response ampli-
tude and the signal quality (SNR) can be assessed.  This display supersedes the
information provided in the Response Analysis panel.

Use of the spectrum and waveform cursors

Detailed examination of the TEOAE spectrum
If it is required to see the detailed spectrum content of a TEOAE, an enlargement of
panel I can be obtained by selecting Spectrum from the Analysis menu, or pressing
the hot key F3 (Fig 22).

The left and right cursor keys allow the level of response and noise to be measured at
any frequency.  The PageUp and PageDown keys provide course movement of the
cursor.  The Home and End keys move the cursor to the maximum and minimum
frequency.  The spectrum is usually quite irregular.  There is no clinical significance to
the detail seen.  Changes in detail may, however, relate to changes in cochlear status.

Fig 22
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A band of frequencies may be selected for further examination.  Set the cursor to the
lower frequency of the band required and press L.  Position the cursor at the highest
frequency required and press U.  Pressing B at this point will band-limit the OAE
response.  The regular Response Waveform panel (G) will then display only that part
of the OAE between the frequencies specified.  In this way it is possible to examine an
OAE response in frequency band sections.  This is useful when substantial frequency
regions have been obscured by noise but other regions have escaped noise contami-
nation.  A band-limit operation can be reversed by pressing the hot key F10, or by
reloading the data from file.  (The band defined in this way has a secondary use in
specifying the frequency limits of noise generated in the stimulus wave research
function, which is not described in this manual.)

Two alternative spectrum display formats are available.  With the large spectrum
already displayed, pressing F will display a smoothed spectrum and key H will display
a blocked histogram.  These are useful only if it is required to document the OAE
response at individual frequencies.  The F and H options assist in averaging the
response and reduce the quantity of data generated.  The default format is restored by
pressing R.  To assist with the documentation, individual frequency points can be
printed by pressing P and at the same time pressing the left or right cursor key.  At
each cursor key press, a line is sent to the printer indicating frequency, response and
noise level intensities.  (Some printers will not print less than a full page without a
manual page feed instruction).  Alternatively, the information can be sent to the file
ILOFFT.TXT.  To do this, the key A is pressed.  The frequency is incremented by one
place each time the key is pressed and a line is appended to the text file in simple
ASCII format.  Pressing F1 provides essential help on the above topics.

OAE waveform documentation
If it is required to document details of the OAE waveform, a cursor key can be obtained
by pressing the hot key F5 or selecting the Waveform option on the Analysis menu.
The left and right cursors control the cursor bar, allowing the sound pressure of the
OAE waveform to be read at intervals of 40 microseconds with the standard stimulus
and 50 microseconds with the Quickscreen stimulus.  The individual peaks and
troughs of the OAE sound wave have no clinical significance.  Changes in these peaks
may relate to changes in cochlear status but may also be influenced by changes in
middle ear status and probe fit.  The PageUp and PageDown keys provide course
movement of the cursor.  The Home and End keys move the cursor to the start and
end of the waveform response.

A limited time window may be extracted for further analysis.  This is achieved by
positioning the cursor at the start of the time window required and pressing S.  The
cursor is then moved to the upper window (the numeric readout shows the time interval
from the marked start point).  Pressing the E key marks the end of the required time
window.  Pressing W will result in the windowing of the OAE by the time period se-
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lected.  The default rise and fall time is 2.5ms and is of cosine form.  This may be
changed by marking the end of the rise required and pressing R.

When an OAE response has had a window applied, it is immediately reprocessed so
that the ILO response screen measures the intensity of response within that time
window.  This is useful to separate out and measure OAE responses confined to short
durations, which would otherwise be obscured by the general noise background.
Pressing the F10 hot key will restore the waveform to its un-windowed form.

Test progress
The inset graphs in panels H and C show the history of the reproducibility and the
stimulus stability during the recording.  An enlargement of this may be obtained by
pressing P, or alternatively by selecting the Progress option from the Analysis menu.
The numerical data gives values of waveform reproducibility, stability percentage, peak
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stimulus dB and noise level at ten time intervals equally spaced throughout the test.
These are shown graphically from left to right.  The example shows a steady rise in
waveform reproducibility due to averaging and a small drop in stimulus stability half-
way through the test.

Test Progress History Analysis is useful in assessing the technical quality of a record-
ing.  For example, if the probe has become dislodged during the test and the final
stimulus stability is zero, it may still be possible to determine at what point in the test
the probe became dislodged and whether to accept or discard the results of the test.
The History Analysis panel can be cleared by pressing C.

Test protocol and ILO Stop Logic
Facilities are available for the operator to control the point at which the recording is
terminated.  The recording may be terminated at any time by pressing the Enter key
and the default protocol is for the recording to automatically terminate after 260 low
noise sweeps.  The operator may set additional conditions for the test to terminate,
including conditions based on unsatisfactory stimulus and noise values and satisfac-
tory OAE response values.  The purpose of this facility is to reduce time wastage,
either by extended recordings in unsatisfactory conditions, or by unnecessarily long
recordings when the OAE response has been very quickly resolved.   The facility is

also useful as a support in the training process.  The
operator can set limits on the duration, stimulus
levels and other parameters of the recording session.

The Stop Logic protocol may be selected from the
opening Version5 block selection screen, or by
selecting the Terminator option in the Analysis
menu inside the program.  Protocols are contained in
files ending with the extension .STP.  From within the
program, select the Stop Logic option from the
Settings menu.  A list of the current automatic
termination parameters will be seen.

The name of the protocol file from which these
parameters are drawn is shown.  Each parameter is
identified by a single number or letter, shown on the
left-hand side of the panel.  On pressing this key, the
specific parameter may then be altered by use of the
cursor.  The number is accepted by pressing the
Enter key.  After editing the protocol list, the list may
be resaved by pressing S.  Protocol files should be
write-protected to avoid tampering.  An edited
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parameter list cannot be resaved if it has been write-protected.  It can be saved under
a new protocol name and this file may be optionally write-protected.  Otodynamics
supplies only an example protocol file, which sets broad safety limits on the recording
process.  Operators are recommended to work with the ILO system and to consult with
other users before introducing their own protocols.  An explanation of the protocol
parameters is given below.

0 ASSESS EVERY : Determines how often the software examines the data for compli-
ance with the protocol parameters.  The default is 260 blocks where each block is
comprised of a pair of non-linear stimulus sets and corresponds to one count of the low
noise sweep counter in the Noise panel.  Reducing this figure will increase the speed
of reaction to conditions requiring test termination, but will slow down data recording
due to the time taken to redraw the screen.  Any parameter can be effectively deacti-
vated by setting its value to be outside of the normal range, e.g. setting the
‘MUCHDATA’ parameter to 9999 will probably result in the test terminating on some
other condition.  By setting the ‘LOWSTABILITY’ parameter to 0, the test will not
terminate solely because of the loss of stimulus, but may nevertheless terminate
because of the excessive noise reaching a displaced probe.

1 LONGTIME : Defines the maximum time for which a test will be allowed to run.

2 MANYREJECTS : Causes the test to terminate unconditionally when this number of
sweeps have been rejected.  This may indicate excessive noise.

3 MUCHDATA : Causes the test to terminate unconditionally when this number of
sweeps have been accepted for averaging.  This would indicate that no previously
defined good or bad condition had been reached throughout the test.  The default
value is 260.

4 HIGHSTIMULUS : If the peak stimulus level exceeds this value continuously for more
than approximately three sweeps, the test is terminated unconditionally to protect the
patient from excessive stimulation.  This condition can also be the result of excessive
noise from the patient.

5 LOWSTIMULUS : If the peak stimulus level falls below this level, the test is termi-
nated unconditionally.  This may indicate that the probe has become dislodged.

6 LOWSTABILITY : If stimulus stability reaches this low level, the test will be uncondi-
tionally terminated.  This could indicate that the probe has become dislodged.

7 MUCHNOISE : If the noise indicator bar reaches this level on a number of consecu-
tive occasions, the test is terminated.  This action can be disabled by setting the value
well above the normal range of noise levels.

8 DEADNOISE : If this low level of noise is reached, the test is terminated as it is
assumed that this must be due to the failure or disconnection of the probe or its having
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become blocked.  A suitable value for this parameter may be obtained by observing
the noise level with the probe disconnected, e.g. 10 micro Pascals.

NB:  The above conditions represent absolute limits outside of which the recording
cannot proceed.

The following parameters relate to quality factors from which the operator may build a
set of conditions for the test to terminate because a satisfactory result has been
achieved.

9 GOODRESPDB : When the response reaches this decibel level, the test will termi-
nate provided conditions B and C have been met.  This is useful in terminating the
recording early in the case of an exceptionally strong OAE response.

A - GOODREPRO : When the quality of accumulated incoming data has reached this
level of reproducibility, the test will be terminated, provided condition B is met.    This is
useful in terminating the recording early in the case of an exceptionally strong OAE
response or a response recorded in exceptionally quiet conditions.

B - MINIMUMDATA : This number of accepted quiet sweeps is necessary before any
automatic termination of the test based on OAE response quality or strength.  This
protects the statistical validity of the test and should not be set very low.  We consider
that 60 blocks is a suitable minimum.

C - MINIMUMREPRO : This degree of reproducibility is necessary before any auto-
matic termination of the test based on OAE strength.  It is not necessary to set this
value to a reproducibility level which, in itself, guarantees validity.  If set to zero, it
allows the other quality parameters to become active, in particular the half-octave band
based measures.  Minimum repro should be activated only when the frequency band
measures are not to be used.

D - MIN N GOODSNR : This parameter refers to the OAE signal-to-noise ratio evalu-
ated in half-octave bands.  It defines the minimum number of bands which must
contain a valid OAE before the test is automatically terminated.  The test will be
terminated only after conditions C and B are met.

E - MIN SIGNIFSNR : This parameter defines the signal-to-noise ratio which an OAE in
a half-octave band must have in order to be considered significant.  This is a separate
indicator to the level set in G, which defines the acceptable level for a pass.  Param-
eter E is used to count the number of marginal half-octave bands.  The default is 3dB.

F - FIXED TERMINATION : Switches off the automatic stopping logic and reverts to
fixed sweep number termination.
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G - GOODSNR DB : These values define for each half-octave band the signal-to-noise
level judged by the operator to indicate a valid OAE in that band.  On pressing G, the
figure for each half-octave band is highlighted in turn.  As each value is adjusted and
the Enter key pressed, the next value will be highlighted, etc., until all of the values
have been edited.  It is useful to control the acceptable signal-to-noise level in each
band as experience shows that much higher values for signal-to-noise can be obtained
for mid-to-high frequency bands than for low frequency bands.  This, however, de-
pends on the local noise environment.

Q - QUALITY : Similar to G, but the decision is based on the value of the reproducibil-
ity in each band, rather than the signal-to-noise level.

N - NOISEFLOOR : Defines the level of noise in each half-octave band at which it
would be considered that any OAE in the normal range would have already become
visible.  These values serve to set a limit on extended recording.  When this limit is
reached and the recording has not already been stopped by other conditions, it may be
assumed that no OAE has been found.  The five parameters are individually set as for
G.

P - PROBABILITY : This is active only when advanced statistical interpretation is in
use.  It defines the minimum probability of an emission being present in a band.

H - NOISE HI dB : Defines the level of noise present in each half-octave band at which
normal levels of OAE would be obscured.  No decision is possible under these circum-
stances, so the test is considered invalid, if no OAE is present.  If an exceptionally high
OAE is nevertheless seen, this evidence can be accepted.

R - RETRIES : If this value is set at other than zero, the software will make an early
assessment of the data after a number of sweeps shown following the @ character.
The software examines the data for some evidence of a significant emerging OAE
response in the half-octave band analysis.  The level of significance is set by the dB
value following the X NSNR figure.  If no evidence is found, the operator will be offered
the opportunity to restart the test after examining the probe.  If evidence of an OAE is
found, the test will continue automatically.  The most common cause for the ILO failing
to detect an OAE in healthy newborns is debris or incorrect probe fitment.  The opera-
tor will be recommended to inspect and refit the probe after changing the tip, if neces-
sary.  R defines the number of retries that will be offered before continuing with the full
test.  To change the time at which the early assessment is made, the @ key is pressed
and the number adjusted.  To change the level of significance, press X.

J - MAX REJECTLVL : This limits the freedom of the operator to raise the noise
artefact reject arrow level.  This prevents recordings being made under levels of noise
judged to be too high for quality recordings.  The experienced operator may wish this
restriction to be removed.  This can be achieved by setting the parameter to be greater
than the normal range of the noise reject level.
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NB: Pressing the F1 key at the Stop Logic parameter protocol list will provide essen-
tial help information.

When a recording is terminated according to the Stop Logic protocol, the condition
which initiated the termination is printed on the screen under the OAE waveform.  This
information is also stored when the file is saved and is recalled on review.

Alt+R  : When recorded data is being displayed, pressing the keys Alt+R will result in
the current data being re-evaluated according to the protocol.  The Stop conditions it
fulfils will be listed on the screen.  This is a useful way of evaluating recordings made
prior to the implementation of a protocol or of evaluating a new protocol  against a set
of previously reviewed data.
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Use of the ILO Statistical Analyser

The ILO Statistical Analyser is called by selecting ILOSTATS from the Analysis menu.
This hands control to the ILOSTATS program, which is designed to perform retrospec-
tive analysis on the entire contents of the current TEOAE data directory.  The purpose
of this analysis is to provide the manager of a screening programme with the average
values for each of the measurement parameters shown on the ILO data screen across
a large number of patients.  Currently, the maximum number is 1,000.  The program
also determines the 5th and 95th percentile values of each measurement parameter.
For example, it can provide the mean OAE intensity obtained from a group of patients
and indicate the OAE intensity levels which separate the 5% lowest levels from the
normal population range.

This data can be useful for quality control purposes.  Regular analysis of patients’ data
can be used to detect changing noise levels in the test environment and changes in
protocol by the test operatives.  It can also be useful to set local criteria for passing
and failing individual ears belonging to a identified sub-group, e.g. infants between six
months and one year, newborns, etc.  It has been used to compare the OAE intensity
and test duration in each of the first three days from birth.  It is typically found that the
mean OAE intensity on the first day is lower than on subsequent days.

On entering the ILOSTATS program, the following process is carried out.

(a) The individual data records are automatically read in, in summary form, from the
data directory.

(b) The means of every recorded parameter are calculated and displayed.

(c) The distribution of values around each mean is analysed to identify the 5th and
95th percentile points.  The program also identifies the 10%, 15%, 85% and 90%ile
values.

Options are then available to display the distribution of any measurement parameter
graphically (Stat Scan P%); to display a scattergram relating to selected parameters,
e.g. reproducibility against time of test (Scattergram); process data may be saved in
binary form for future recall (Stat BSave); or in word processor readable form (Stat
ASave).

This utility is provided to assist with the management of test programmes and the
development of local protocols and criteria.  Use of the program has no influence on
the measurement of TEOAEs by the ILO and operates independently on stored data.
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Graphical display of stimulus level
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ILO88 menus

Version5 software introduces for the first time with ILO88 software a fully mouse-
operable menu system.  This section describes the mouse-operable menu system,
which is the default whenever the mouse option is checked in the ILOCFG configura-
tion program.  The menu system can be changed by hiding the toolbar under the
Options menu.

The ILO88 TEOAE toolbar

When the mouse control option is active, the ILO88 Toolbar is seen at the top of the
screen.  Drop-down menus can be selected by mouse or keyboard.  There are nine
main menu titles.  Each one is highlighted as the mouse passes over and a menu
drops down.   The menu is cleared by the Escape key; the highlighted menu title can
be changed using the left and right cursors.  The down cursor will cause the menu to
drop.  The menu can also be called by pressing the underscored key in the menu title,
e.g. F for File menu.

When a menu is showing, the highlighted item can be changed by pointing the mouse
at another item, or by the use of the up/down cursors.  When highlighted, an item can
be selected by pressing the Enter key, or the key corresponding to the underscored
character of the item name, or by clicking the mouse.  The left/right cursor keys cause
the left or right menu to replace the one currently showing.

Some items cannot be activated and this is indicated by lighter text.  This occurs when
related essential selections have not been made or when it is not appropriate to use
the item.  If an option is not installed or appropriate for your system, all associated
items will be shown in lighter text.

Some items are used to turn on and off the function.  When the function is already
operative, a tick (check) is shown at the end of the line.  Selecting an item already
checked will cause the option to be turned off.  Also, when data is available for saving,
the Save item is checked.  The check clears once the data has been saved.

Some items  have a hot keystroke indicated at the end of the name.  You may use this
hot key to activate the function, even where the menu is not showing.

The toolbar can appear without any highlights.  In this case, select a main menu title as
detailed above.  The selection of some items causes a secondary menu to appear.
This is operated in the same way.
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Files menu

This menu contains general utilities concerned with filing and retrieving test informa-
tion.  It also includes the exit route.

#TL0101

Files > Review
This shows the list of patient data
files stored on the current data
directory, together with the
graphical summary of the OAE
recorded.  Review may also be
called by pressing the F7 key.

A particular file is selected with the
cursor keys or mouse and loaded
into the main screen by pressing
the Enter key.  The panel is
headed by the name of the
directory being reviewed.

The graphical summary panel
shows, from the top down: stimu-
lus waveform;  OAE power
spectrum analysis (not for SOAE);
response waveform or SOAE spectrum; the name, type of test and main parameters.
The frame of the summary panel is coloured blue for a left ear and red for a right ear.

If the test was subject to an automatic stop procedure, the reason for termination is
shown as a numerical code (see Appendix : ILO Codes).  If the test has previously
been scored within the ILO, its file name extension will reflect the score.  The score is
shown in the graphical summary stimulus panel as P!, Q!, R!, I!, representing PASS,
QUERY PASS, REFER and INVALID test respectively.  The list entry colour also
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indicates whether the test has been scored (Pass - green; Refer - blue; Invalid Test -
red).

If Escape is pressed, a keystroke menu will appear giving the opportunity to select a
new directory or to pre-select a group of files of the same patient or test session if
available.   Press key N to enter a new directory, key S to select on patient’s name.
Type the whole or the first part of a name to select a patient group.  Once selected,
these files will appear in the review panel.  If Escape is pressed, the keystroke menu
will show the option to cancel the selection, X. It will also give the option to save the
selected group names as a file.  This filed list may later be used to batch process the
group of files.  (See Batch Copy, #TL0110).

To change the review format, key C to list patient case notes, P to list patient’s name
and F to list file name only.

#TL0102

Files > Save
Saves newly collected or modified data to the current data directory.  The file name is
automatically selected.  Once a recording has been saved, it cannot be re-saved.  The
Save menu item is checked when new data has not yet been saved.

#TL0103

Files > Save As
Saves As allows data to be saved on the current data directory using a name provided
by the operator.  The normal extension for ILO data is .DTA and this should be used to
ensure that the data can be recognised and read by the ILO Review command.

#TL0104

Files > Ear/Patient
This item activates a secondary menu concerned with
identifying the patient and ear to be tested and also with
searching for the patient’s files.

#TL2501

Ear/Patient > Patient ID
Allows the patient’s identification to be entered prior
to testing.  It automatically applies to the next test
recording.  The Patient ID consists of the patient
name (up to 17 characters), the Ear and the Case
Note or Hospital Number (up to 10 characters).  This
data will eventually be saved with the test recording.
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#TL2502

Ear/Patient > Edit ID
Allows previously entered patient data to be changed.

#TL2503

Ear/Patient > Mistaken Ear
Allows for the correction of data files where the wrong ear was entered.  Select
‘Correct the ear?’ to change the ear.  You will then be able to re-save the data,
over-writing the original file if required.

#TL2504

Ear/Patient > Name Search
This searches the current directory for other files containing the same patient
name.  The name of the last tested or last recalled file is automatically adopted but
can be changed or edited.  It is possible to search using only the beginning of a
name.  When the search is complete, Review is called, listing all the matching files
found in the directory.  The Review panel header clearly states that a file selection
is in operation.  The group of  files selected may be retained or cleared.  The
highlighted file may be loaded.  After loading, you will be asked to confirm the file
selection.  If the file selection is retained, then subsequent calls to review will show
only the selected files.  This may be cleared at any time using Escape then X from
the Review panel.

#TL2505

Ear/Patient > Case Search
This performs a review of patient
data files in the current directory.
Grouping is according to the Case
Note portion of the Patient ID.  If no
Case Note was entered, then the
Patient Name is substituted for the
Case Note, preceded by a colon.

Only the first file of each case
group is listed.  In the Case Select
summary panel to the right, the
Case and Patient Name are
repeated, together with the total
number of files found matching that
identity.  The cursor can be used to
examine the number of files in
each case.  When a case is
selected by highlighting and pressing Enter, or clicking with the mouse, all of the
files belonging to that case are displayed in the Review panel, together with a
graphical summary.  Data may be selected as in Review.
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#TL0105

Files > Score & Save
Operates as the Save option, but precedes the Save function by showing the scoring
bar on the top of the screen.  After inspecting the data, select PASS, REFER or
INVALID from the scoring bar.  The selected item will be highlighted.  A questionable
Pass may be marked by pressing the Q key.  Confirm the score by pressing the Enter
key.  You will be required to enter your personal ID as a scorer.  On pressing the Enter
key the data is saved using the ILO automatic file naming system.  Scoring affects the
extension of the file name.  Pass results in .DTP, Refer as .DPR and Invalid as .DTI.  A
queried Pass has the extension .DTQ.  An entry is made in the Note Book as the data
is saved.

#TL0106

Files > Note Book
Note Book provides an easy means of making notes for
later editing.  It calls the Microsoft Edit program.  The
default filename is NOTEBOOK.TXT, but this may be
changed.  The default location is the directory from which
ILO-V5 is called.   A full range of basic editing functions is
available.  The file created is in DOS Text format, which
may be imported into all word processing programs.

Each time a test result is saved, an entry is automatically
added to the Note Book file NOTEBOOK.TXT.  An exam-
ple follows.

FILE: 97061102.dta
DATED: 11/06/1997 TIME: 8:17: 3
SUBJECT: G BROWN EAR: left
CASENOTE: HP190659
TEST TYPE: QuickScreen
PROTOCOL: NEWBORN STOP AT: GoodSNR
SCORE: PASS

This entry is added at the end of the previous text and additional notes can be made
as required.  Ctrl+End will immediately take you to the end of the Note Book text.  The
score is entered automatically only if the Save & Score option is selected.

If you are operating an Otodynamics Echoport, then caution should be exercised when
directly printing from the Note Book since your printer port may already be committed
to your ILO hardware.
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#TL2701

Notebook > Notes Review
This displays the current contents of the Note Book.

#TL2702

Note Book > Find a Name
Displays the notes associated with the patient name entered.

#TL2710

Note Book > Backup Notes
Copies the current Note Book onto a backup file, NOTEBOOK.BAK.

#TL2711

Note Book > Restore
Replaces a current Note Book with the file NOTEBOOK.BAK.  The current Note
Book is backed up.

#TL2712

Note Book > Erase Notes
Clears the current Note Book.  A backup is made.

#TL0107

Files > Directories
Directories activates a secondary menu, as shown, providing
review facilities for all directories and a means of changing the
special ILO88 directories.

#TL1601

Directories > Explore DIRS
This initially shows only sub-directories within the primary
ILO-V5 directory.  Once a directory is selected (stage two),
all files in the directory are shown.

The special ILO88 directories, e.g. ECHODATA, are
coloured yellow and identified (other directories are coloured green).  The default
special directories names are:

ECHOPROG : ILO Program directory
ECHODATA : patient file directory
ECHOSTAT : all ILO statistical database files and automatic stop procedure

files
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ECHOIMAG : for screen images as PCX files
ECHOBACK : used to back-up patient files after scoring and/or deletion
ECHOSPOO : data spooling files of unprocessed patient data
ECHOSTIM : contains the special calibration stimuli and any custom stimuli

designed by the user.

In stage two, all files within the selected directory are listed, file name and data
filing are shown.  If the file is an ILO datafile, its graphical summary will automati-
cally be displayed and the file may be loaded in the normal way.  Other recognised
files are ILO spool files (.MEG), image files (.PCX) and ILO stop protocol files
(.STP).  Both MEG and STP files are accompanied by brief contents summaries.
PCX files can be loaded for viewing directly from Explore.

In Explore, buttons appear above the review window allowing the drive or the file
extension listed to be changed.  Selection can be made by clicking the mouse or by
keying the highlighted letter.  Within the Explore review panel the route directory
can be selected.

Changing Special Directory Names
The following menu items allow different directories to be nominated to receive ILO
data files, image files etc.  Each item below consists of a keystroke menu; select D
to change the directory name; directory listings can also be obtained using keys A
to view existing directories at the ILO-V5 level and F to show appropriate ILO files
within the current special directory listed.  If a new directory name is requested
which does not already exist, you will be given the option to create a new directory.

#TL1602

Directories > Data TE DIR
The recorded data directory.  The default is ECHODATA.

#TL1603

Directories > Stimulus DIR
The Stimulus Library, where custom stimuli are stored, including the probe test
calibration stimulus.  The default is ECHOSTIM.

#TL1604

Directories > Stats DIR
Interpretative statistics directory, where normative information can be stored and
retrieved for comparison with individual records.  The default is ECHOSTAT.

#TL1605

Directories > Images DIR
Screen image directory, where PCX images of particular displays can be stored
and retrieved using the key sequence Ctrl+U and Ctrl+V respectively.  The default
is ECHOIMAG.
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#TL1606

Directories > Spooling DIR
Data spooling directory, where raw data collected during a test may be saved for
later reprocessing.  Ctrl+Y will open up the data spooling facility, Ctrl+X initiates a
recording and Ctrl+Z reloads raw data.  The default is ECHOSPOO.

#TL1607

Directories > Config DIR
Contains the ILO88 configuration file, CONFIG.ILO.  The default is ECHOPROG.

#TL1608

Directories > File of DIR
Creates a list of the names of data files held in the current data directory to a file of
the user’s choice.

#TL1609

Directories > Make Default
Makes the current choices for data, stimulus and stats directories default on next
entering the ILO program.

#TL1611

Directories > Open New DIR
This creates a new directory on the current disc using the DOS instruction ‘MKDIR’.
The full pathway may be entered, e.g. see: MYDATA:TUESDAY, in which case the
directory will be created exactly as written.  Alternatively, a single directory name
may be entered, e.g. TUESDAY, in which case this directory will be created at a
level parallel to the other directories used by the ILO.  For example, if the ILO is
currently installed in the directory C:\ILO-V5, then the directory created will be
C:\ILO-V5\TUESDAY.  The directory created will appear on the Explore list when
next accessed.  Creating a new directory does not change the allocation of directo-
ries to specific ILO data functions.

#TL1612

Directories > New Data DIR
This provides a convenient way to select a new directory on which to record and
review OAE data.  It replaces the directory ECHODATA or the current data direc-
tory if different.  The review panel displays current directories in the ILO-V5 direc-
tory.  Special ILO directories are coloured yellow; other directories are coloured
green.  You may select any directory for the current data directory except those
already allocated to other specific ILO functions, e.g. ECHOSPOO.  On selection,
the directory automatically becomes the directory for saving and reviewing data.
Selection of a new data directory by this method does not change the default
directory, which will be adopted next time the program is run.
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#TL0108

Files > Print
Print activates a secondary menu providing print and print
control options.  The screen may be printed at any time by
pressing Ctrl+P.

#TL2001

Print > Print Screen
Sends the current display (with menu removed) to the
selected printer.  This function is also duplicated by
Ctrl+P, which may be operated at any time without
invoking the menu.

#TL2002

Print > Send To File
As Print Screen, but does not transmit the image to the printer immediately.  The
image is stored for future use as a file.  The file is stored in the sub-directory
PRTSTORE located in the ECHOPROG directory.  The file is specific to the printer
type already selected and carries the short-form name of that printer.  The file
extension is incremental from 000 each time a file is created.

#TL2003

Print > File To Print
Allows previously filed screen prints to be transmitted to the selected printer.  Only
files named appropriately for the selected printer can be transmitted.  On selecting
File to Print, a list of files awaiting printing is shown, together with the date of the
files’ creation.  These files are automatically deleted after printing.

#TL2004

Print > Use Spool
When checked, print output is temporarily stored to a disc file and printed after
completion.  This is useful when two tests per page are being printed.  It also
increases overall efficiency.  It is normally checked.

#TL2005

Print > Light Color
This removes the grey background from color prints, saving ink and aiding legibility.
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#TL2006

Print > Delete Files
Allows a screen print sent to file and no longer required to be deleted.  Print files
are automatically deleted after printing.  A maximum of 100 print files are allowed
for each printer.

#TL2007

Print > 2Tests/Page
Holds the first print in memory until a second print operation is made.  This is useful
for printing left and right ears on the same page.

#TL2008

Print > ASCII File
Provided only for compatibility with earlier versions.  It provides an elaborate
numerical listing of some ILO88 parameters in character format with quotes and
commas used for delineation.  This is compatible with some databases and
spreadsheets.  There are options for including waveform and FFT information in
the file.  It is not recommended that this is used as a routine data logging facility.

#TL2009

Print > Text Report
This item is reserved for a future OAE test report facility.

#TL2011

Print > Install DRV
This allows additional printer drivers to be installed from floppy disk.  Supplemen-
tary drivers will be issued from time to time by Otodynamics as new printers are
marketed or will be supplied to customers to meet individual needs.  Insert the
printer driver disk into drive A and press Enter.  If no drivers are present on the
disk, a File Not Found error will be shown.  Existing drivers will be over-written by
the new drivers of the same name.

#TL2012

Print > Printer Type
Lists all available printer drivers.  The main review panel shows the driver name.
The highlighted name can be selected with the mouse or the Enter key.  On the left
is a summary of the driver which is highlighted, including the manufacturer, model
name and printing scale.  Also shown in the summary panel is the name of the
current printer and the current printer port, e.g. LPT1.  The printer port can be
changed by pressing P.  The information line at the base of the screen gives
additional information regarding the highlighted driver.
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On selecting a driver, a message is displayed.  Pressing the Enter key confirms the
use of this printer for the remainder of the session.  Pressing M copies the printer
driver to the default file, MAIN_PRT.  On next starting up the ILO program, the
printer selection will revert to that previously entered in the ILOCFG configuration
program.  The entry in this program needs to be changed for a permanent change
in printer type.

#TL0109

Files > Load Spool
This item is not normally active.  Activation requires a research version of the software
and also that data spooling is set on in the Settings menu (see below).

Load Spool allows a raw data file (MEG file) to be loaded and a previously recorded
test sequence to be replayed.  A listing of available spool files appears in the review
panel.  Selection is by mouse or Enter key.  On loading, an indication of the length of
the recording is given, together with the name of the subject and ear.  The loading of a
spool file  has no influence on the normal operation of the ILO88.  (See Replay Spool,
#TL0207).
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#TL0110

Files > Batch Copy
Provides utilities for the manipulation of groups of
data files.  Individual or groups of data files can be
selected, as in Review.  Press Enter for the review
panel, select a file by highlighting and pressing
Enter or clicking the mouse.  The selected file
name will appear on the selected batch list.  Press
Enter to select another file for the batch list.  They
may then be directed to a back-up disk (F2) or to
the printer (F4) or to a list file (F5).  F3 combines
the functions of F2 and F4.  The group may be
deleted using F9 - a warning is given.  If no file
selections are made, then all of the files in the
current directory are processed by F2, F4, F5 and
F9.

#TL0111

Files > DOS Command
Temporarily exits to DOS for command line
instructions.  Type EXIT to return to the ILO.

#TL0112

Files > Exit Options
Immediately terminates the ILO88 program if all current data has been saved.  If not,
an invitation to save current data is given.  The program exits to the opening block
selection screen, from which TEOAE or DPOAE recording can be selected, together
with other utilities.
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Tests menu

The test menu (above left) provides a selection of testing options and access to testing
utilities.  Once a test is commissioned, the right-hand panel will be seen.  This gives
options to full control of the test.  The mouse is not operative on the right-hand panel.
Keystrokes must be used during testing itself.  Please refer to Managing a TEOAE
Recording for further information.

#TL0201

Tests > QUICK TEOAE
Performs the QuickScreen TEOAE test.  It automatically installs the Low Cut Filter,
which assists in artefact rejection.  No further selections are available after the Checkfit
stage.

#TL0202

Tests > TE fullmenu
Provides for the full choice of TEOAE test options.  All
tests begin with the Checkfit function and this is followed
by the Test Option secondary menu.

#TL1101

TE Select > Preset TE
This performs the default original TEOAE test using
an 80 microseconds non-linear click stimulus and
20.48 milliseconds sweep time.  This default test can
only be changed in research installations.
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#TL1102

TE Select > Checkfit
This performs the standard ILO88 fit adjustment test using the default click stimu-
lus.    During the Checkfit process a keystroke menu is shown, allowing the artefact
reject level to be set using the up/down cursors and the stimulus level to be
normalised using the automatic gain adjustment (key A).  Other useful functions
include the key O, providing a real-time oscilloscope monitor of the ear canal
sounds and key S, which will cause stimulation to temporarily pause.  Press Enter
or G to go on with the testing.

#TL1103

TE Select > QuickScreen
This initiates the QuickScreen test protocol as in Quick TEOAE on the main Tests
menu, but without the automatic application of the Low Cut Filter.

#TL1104

TE Select > Tone Pip TE
This is identical to Tone Pip TE on the main tests menu.

#TL1105

TE Select > SOAE Check
This is identical to the Spontaneous option on the main Tests menu.

#TL1106

TE Select > KeepLinKwik
This option provides a QuickScreen test in a form which keeps both the linear and
non-linear components of the response.

#TL1107

TE Select > Probe Check
This option performs a special test which reveals errors in the probe calibration,
usually indicating contamination (see Calibration section).

#TL1108

TE Select > Linear TEOAE
Performs a measurement on the original 20.48 format using quick stimuli of uniform
height.  This method has the advantage of lower noise levels and greater sensitivity
to OAEs than the standard non-linear default test (preset).  It has the disadvantage
of greater susceptibility to artefacts of ear canal ringing origin.  It is not recom-
mended that this option is used routinely and it is essential that it is never used with
high stimulation levels.  Ear canal acoustic artefacts occur at the commencement of
the response trace and are usually easily recognised.  They can be removed from
the response using the waveform editor (F5) or the Analysis menu.
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#TL1109

TE Select > NonLinear TEOAE
Performs the standard default ILO88 test, identical to the preset option above.  It is
provided here to ensure the default test remains available when the preset option
has been changed in research installations.

#TL1110

TE Select > Experiments
Initiates a third-level menu providing tests of special interest to auditory research
laboratories.  This menu can also carry custom functions.  These options are not
available on standard software but only on research software.  They are detailed in
the Research Supplement.

#TL0203

Tests > TonePip TEs
After the Checkfit process, a keystroke menu is provided which allows for the fre-
quency of the stimulus tone pip to be selected.  The parameters of the tone pip
(amplitude, length, plateau, multiplex) are also noted but cannot be changed from this
menu.  (See Settings > Stimulation > Waveform > Tone Burst).

#TL0204

Tests > Spontaneous
Spontaneous performs a synchronised spontaneous OAE activity test.  A special data
collection procedure operates.  A click stimulus is applied at one quarter the normal
rate.  Data is captured during the periods that no stimuli are given.  Synchronisation of
the SOAE by the trigger stimulus ensures temporal synchronisation.  This allows
synchronous averaging to be employed to extract very small spontaneous emissions.
An advantage of the protocol is that it discriminates against tonal noise in the environ-
ment.  A disadvantage is that is records ‘quasi-spontaneous emissions’ which may be
present only for short periods after stimulation.

#TL0206

Tests > Continue F8
If selected immediately following a test, the test is recommenced.  This option will be
checked (4) if continuation is possible.  This is useful if a recording was abandoned
due to patient noise and then can be continued.
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#TL0207

Tests > Replay Spool
This function relates to reprocessing raw data saved during
the previous test or loaded from disk.  Before the facility can
be used, it is necessary to open the data spool using the
Settings menu.

#TL2901

Replay Spool > Re-run Test
Re-presents the raw data stream from the probe for reprocessing.  Applies only
when raw data has been previously spooled to memory and saved.  See Settings
option, Data Spool and also Load Spool.

The following options are only available when advanced statistical processing is
enabled.  This facility is not available on all installations.

#TL2902

Replay Spool > View Sweeps
#TL2903

Reconstruct
#TL2904

Super Reject

#TL0208

Tests > Write Spool
Operates only when the Data Spool option has been activated.  When selected, the
entry is checked and raw data from subsequent tests is kept in memory.  This process
may slightly decrease the efficiency of recording on slower computers.  When writing
to spool is occurring during the test, this is indicated in the Patient ID panel.  To cancel
the Write to Spool option, select Write Spool a second time.
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#TL0209

Tests > Calibration
Calibration provides facilities for the confirmation and
calibration of the ILO system by the user.  We recommend
the complete ILO system is checked at least once per
week or if the user is doubtful as to the condition of the
probe.  The most thorough test of the whole system is
achieved using the Probe Calibration test.  If this test
shows substantially differing readings from previous tests
with this probe, a complete Equipment Test should be
undertaken to eliminate possible electronic errors.  If the
system is to be used to record data for research purposes
or for comparison with data from other centres, or with
data collected on other probes, then the acoustic calibra-
tions should be undertaken.  Acoustic calibrations require access to external calibra-
tion equipment not supplied by Otodynamics but available in most audiometric equip-
ment service departments.  There are a number of calibration options:

#TL2801

Calibration > Probe Check
This performs a special test on the probe placed into the Otodynamics cavity (not
an ear).  The test records a synthesised OAE consisting of three response tone
bursts which can be compared with the recording made on your probe at the
factory.  This is described elsewhere (the Collecting Options menu, Probe
Calibration).

#TL2802

Calibration > ID of Probe
This displays the current identification associated with the current probe.  In DP
Echoport, TEi, 88i, 88DPi systems the electronic ID of the probe is read automati-
cally.  Not all probes include an electronic ID.  In these cases and also in the cases
of other ILO systems, a zero ID is entered, but the user may name the probe.  The
ILO automatically keeps a log of probe usage for each probe ID and/or name and
this is useful for service and warranty purposes.  See Information > Probe Check
for further details.  The ILO will automatically remind the user to check the probe
after a set number of uses.  In systems where the probe ID cannot be automatically
read, the user must enter or select the probe name when the probe is changed if
the usage log is to remain correct.
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#TL2803

Calibration > Select Probe
This displays a list of probe IDs and names, previously entered and saved.  On
selecting a probe, all usage is logged under that probe’s identity (see above).  If no
probe files are shown, or if a new probe is to be introduced, press ESC to skip the
selection and then enter the name/ID of the probe to be used.  A new probe entry is
saved only after a test is completed.  The ILO can be set to request a probe
selection at start-up (see ILOCFG program Customisation).  With hardware capable
of reading the electronic probe ID, this is not necessary.  We recommend automatic
start-up probe selection in all other cases.

#TL2807

Calibration > Noise Check
This performs a modified ‘Checkfit’ procedure in which the live signal from the
probe is displayed on the screen so that the level and type of noise background
can be seen.  This test is only useful if all the ports of the probe are firmly blocked
(with a finger) so that no external acoustic noise enters the probe.  This will also
ensure that no stimulus sounds enter the microphone.  The level of noise is
represented by the size of waveform fluctuations across the screen.  To obtain a
measure of these, observe the noise histogram on the right-hand panel and adjust
the artefact reject arrow using the cursor keys so that it lies at the maximum of the
distribution.  Then read the peak level of the noise recorded by the microphone at
the top right (Reject dB).  With the probe removed, the instrumental noise will
typically register around 24dB spl (23.7 shown).  With a probe fitted and fully
blocked, the mean noise may typically be 30dB spl (29.7 shown) with peaks up to
36dB spl.

The test is particularly useful in identifying electrical/radio interference.  This can be
caused by improper grounding of the PC or by very strong local radio interference
sources.  Power line interference typically results in spikes which move across the
screen, radio interference takes the form of fluctuating oscillations.

#TL2811

Calibration > SPL 84dB
This performs a modified Checkfit procedure in which the live signal from the probe
is shown on the screen and the sound pressure and peak frequency registered by
the ILO is indicated by a display panel.  Apply a free-field externally calibrated
sound field of 84dB spl at 1kHz and observe the level registered by the ILO.
Standard adult and DP probes should show a figure of 84dB +4/-3dB.  The small
serviceable neonate and general purpose probes have a higher sensitivity and will
show up to 90dB on the display.  A correction of 6dB should be applied to data
obtained with these probes if true spl figures are required.  The response of the
probe at other frequencies may vary (see Calibration > Probe Check above).
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#TL2812

Calibration > SPL 114dB
This is as for SPL 84dB but is designed for use with an acoustic calibrator deliver-
ing 114dB spl to which the probe is directly coupled.  To perform this test, an
Otodynamics calibration kit is essential, which includes a 30dB probe signal
attenuator and acoustic coupler.

Calibration: Additional Information.  The systems of the ILO can be confirmed by
running the Equipment Test program.  A probe should not be inserted during this
test.  With the Otodynamics two-card, ILO92, ILO88 Echoport and ILO288
Echoport, a calibration plug must be inserted replacing the probe.  With the ILO292
and internal systems such as 88i, DPi and 88DPi, the probe should be removed but
no calibration plug should be inserted as this connection is made internally.  A
special test plug is available for checking DP functions of appropriate ILO systems.
For this, a DP cross coupler plug is needed for insertion when requested by the
program.  The Equipment Test functions are discussed in more detail in the
Installation section of this manual.

The ILO system can be regarded as a sophisticated sound level meter and ana-
lyser.  To check the calibration of this function, it is necessary to supply a known
sound to the acoustic probe in free field or within a calibration instrument.  Using
this option, the sound levels as read by the ILO system are displayed.  This data
may be used to apply fine corrections to the measurements made by the ILO and
to detect malfunctioning equipment against previously supplied readings.

OAE probes differ slightly from each other due to manufacturing tolerances.  Also,
for compatibility purposes, Otodynamics ILO probes have the same general
response characteristics as probes supplied with the original ILO machines from
1988.  It will be possible to correct for the frequency response of the new ILO
probes, which include an electronic ID.  Users having suitable equipment can be
supplied with this information on a disk file.  However, there is no clinical benefit
from applying such corrections since judgements on the ILO  are based on signal-
to-noise and relative measurements rather than absolute sound pressure measure-
ments.  However, this correction may be necessary for research purposes.  The
user should note that older instruments (ILO88, ILO92 and Echoport 88 and 288)
are not able to detect the electronic identity of the probe and therefore it is possible
to load the wrong correction file for the probe being used.  The ILO292, the ILO88i,
DPi and 88DPi all have the capacity to read the probe ID if an ID labelled probe is
in use.  In this case, the instrument will give a warning message if the probe being
used has an identity conflicting with the probe correction data currently loaded.
Older probes and most probes supplied in 1997 did not include the electronic
identity facility.  Please contact Otodynamics if you need to use the probe correc-
tion facility.
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#TL0210

Tests > H Database
This option needs to be enabled in the ILOCFG program by setting the custom option
L to 1 and the level of use to be ILO+DATABASE.  The option also requires that a
screening management program such as HiScreen or the Otodynamics screening
manager is installed.

On selection, control is transferred to the data management program where patient
lists can be entered and screening tests initiated.

The ILO is licenced to work directly with the National Center for Hearing Assessment &
Management’s Hi•Screen program.  If registered with NCHAM, selection this option will
call the Hi•Screen program.  With this program, patients’ demographic information can
be entered and screening workloads managed.  Individual TEOAE QuickScreen tests
can be initiated and responses scored and filed.  Please contact NCHAM for further
information.

NB: Even when Hi•Screen is installed in your system, it is necessary to indicate its
use in the configuration of the ILO using the ILOCFG program.

#TL0211

Tests > DPOAEs
When DPOAEs are installed on your system, this
option activates the DPOAE secondary menu, which
provides access to a range of functions previously part
of the ILO92 program.  DPOAEs may also be selected
by pressing the key D.

#TL1001

DPOAEs > DPOAE Suite
Transfers to the DPOAE screen if available on your
installation.  To access the DP menus on this
screen, press M or click on the Menu box.  A
DPOAE measurement sequence may be initiated
immediately by pressing F6.  Please see Part
Three : DPOAE User Manual.  The DPOAE mode can be exited to the TEOAE
mode by pressing T.  Only shows on DP capable systems.

#TL1002

DPOAEs > Gram
Automatically proceeds to the DP-Gram measurement function of the DPOAE
module.
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#TL1003

DPOAEs > Review
Lists the DPOAE patient files.

#TL1004

DPOAEs > Latency
Automatically proceeds to the DP Latency check function of the DPOAE module.

#TL1010

DPOAEs > Protocols
Lists the DPOAE macro programs that have been created by the user, in addition
to those used to provide the fast DPOAE option below.  Select a protocol by
highlighting and pressing Enter or clicking with the mouse.  A message will appear
to confirm that the macro program has been activated.  On next selecting DPOAE
Suite from this menu or by pressing D, the selected program will automatically be
loaded and run.  The selected macro program is automatically deactivated once
used and must be reselected.  The ILO88 keystroke macro programming facility
can be used to automate this process.

#TL1011

DPOAEs > Edit Protocol
Calls the ILO DPOAE macro editor.  This provides standard facilities for editing and
saving protocol files.  Under the Help option, a library of macro commands is to be
found.

#TL1012

DPOAEs > Image DP
When checked, it causes the DPOAE display screen to be captured as a PCX file
at the point of transfer between the DPOAE program and the TEOAE program.

#TL0212

Tests > Fast DPgram
Transfers immediately to the DPOAE program and performs a half-octave DP-Gram
under the control of a macro program V5KWIKDP.MAC.  This achieves efficient data
collection by repeating only those points where the signal-to-noise remains inad-
equate.  The test continues until every point has 10dB clearance above the 95%
confidence noise level.  The test may be terminated manually at any time.  The
specifications may be copied to other file names and edited to form a macro program
suiting the user’s needs.
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Settings menu

#TL0301

Settings > Stimulation
Activates a secondary menu allowing for changes in the
stimulation level and format.

#TL1801 & #TL1802

Stimulation > Gain Stim A
Stimulation > Dual Gain AB
These options allow the stimulus gain to be changed.
Options are available to change only the primary gain
A or gains A and B on certain hardware options.
These relate to the output levels.  Within the adjustment panel there are two
entries.  CHECK FIT REFerence gain controls the level used during the Checkfit
process.  The TEST GAIN operates during the main recording process. These
should normally be set identically.  The TEST GAIN is copied to the CHECK FIT
gain when the R key is pressed.  It is not normally necessary to change the
stimulus gain for screening purposes unless OAE recordings at reduced stimulus
levels are required.  A further option waveform is provided.  Stimulus Maths allows
small changes to the stimulus size for fine adjustments.  The form of the stimulus
waveform presented during the preset mode can also be altered.  (#TL1801)

#TL1805

Stimulation > Auto Adjust
When checked, it enables an automatic adjustment of stimulus level when A is
pressed during the Checkfit.  The level is set using the Target Level option.
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#TL1806

Stimulation > Target Level
Sets the peak stimulus level used for Auto Adjust.  The default setting is 300
milliPascals.  It can be changed using the cursor keys.  Ensure good probe fit
before using Auto Adjust.  The maximum probe output is limited and the target level
may not always be met.

#TL1809

Stimulation > Waveform
Activates a third-level menu available only on
research level systems.  The menu allows for
changes in the waveform of the preset stimulus
and for the saving and retrieval of custom
stimuli.  Custom stimuli should not be used for
clinical purposes.  They are provided for re-
search purposes only.  Users are referred to the
Research Supplement.

#TL0302

Settings > Stop Logic
Calls up the automatic test termination secondary menu.  It
provides facilities for specifying the conditions under which
a test recording will automatically terminate.

#TL1901

Stop Logic > Auto Stop
This enables the automatic stop facility which uses information read from the
preselected stop protocol file (the default file is MANUAL).  When operating, the
automatic stop facility will terminate the test when predetermined conditions are
met.

#TL1902

Stop Logic > Fixed Stop
Disables automatic termination and sets the number of low noise sweeps as the
only terminator of the test sequence, other than manual interruption.

#TL1903

Stop Logic > Load Protocol
Lists the automatic stop protocol files created by the user and supplied by Otody-
namics.  The files have the extension STP and appear in the standard review
panel.  A file summary is shown on the right; this indicates the currently operative
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file and gives details of the highlighted file, including the author, source and date.
STP files can be set as editable or read-only at the time of creation.  Their status is
also indicated in the summary panel.

For further discussion and illustration, see Test protocol and ILO Stop Logic in
Data Analysis Utilities.

#TL1904

Stop Logic > Edit Protocol
Calls the automatic termination keystroke
menu which allows the adjustment of approxi-
mately 50 parameters which can define the
limits of a test.  These are described else-
where.  When activated, the Stop Logic main
menu option is checked and subsequent
tests will terminate automatically when stop
conditions are met.  Automatic stopping can
be disabled by selecting either the Fixed N
option below or by pressing the F key in the
automatic termination keystroke menu.

Stop parameters can be individually altered
using the index code provided and the up/
down cursors.  Edited protocols can be saved
and loaded using the S and L keys.
Protocols can be write-protected and have
provision for notes to be added.

#TL0303

Settings > Data Window
Displays the current setting of the measurement window applied to standard OAE
recordings.  Key W re-windows current data.  We recommend that the newer F5
function be used instead.  Key D superimposes the already applied window onto the
response waveform for information.  Key S can be used to alter the window automati-
cally applied to recorded data.  This would only be necessary if it was decided to
permanently use an alternative stimulus to the standard click stimuli provided.
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#TL0304

Settings > Data Filter
Displays the settings of the band width limit previously set in the F3 cursor spectrum
panel.  Key F reapplies this filter to the data.  Key S allows this manual filter setting to
be changed, but we recommend this is performed from the F3 cursor spectrum panel.
Key S also allows the automatic filter applied to input data to be changed.  The default
is 732Hz to 7324Hz.  The automatic filter is applied to all recorded data and assists in
the removal of unwanted low and high frequencies which might otherwise obscure
valid OAEs.  We do not recommend that these settings be changed.

#TL0305

Settings > Low Cut Filter
This can be permanently set on at start using the customised option N in the ILOCFG
program.  It activates a high pass filter operation on incoming data which is useful in
reducing the interference caused by noise.  It operates to provide additional attenua-
tion below 1000Hz.  On selection, a panel indicates that the Low Cut Filter is to be
switched on or off.  When switched on, a rectangle appears in the Response Wave-
form panel during recording and on recall.  The noise levels indicated during recording
will be reduced by the removal of low frequencies.

#TL0306

Settings > Refresh Rate
Sets the interval between automatic reanalysis and screen updates during recording.

#TL0307

Settings > ILO CONFIG
Allows limited access to the basic default settings through the ILOCFG program.
ILOCFG can also be accessed from the opening Options utility screen.

#TL0308

Settings > Environment
Where installed, this option allows for the current settings on all menus to be stored
and retrieved.
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#TL0309

Settings > Data Spool
Accesses a secondary menu allowing data spooling to be
turned on and off.  When on, all probe signals are saved
prior to analysis and can be replayed - see above.  Data
may be saved to disk and reloaded; note that a typical
test will consume approx. 0.5MB of disk space.  Data
spooling, if left on,  will quickly fill your hard drive.  Data
spooling files may be deleted from this menu.

#TL1701

Data Spool > Create Spool
Reserves the memory required to store raw data for
an entire test.  Computers with restricted memory will
not accommodate long tests.  Only activate the spool if spooling is required.  When
activated, the Create Spool option is checked.  The Data Spool item of the Set-
tings menu and the Load Spool item of the Files menu are also checked.

#TL1702

Data Spool > Include Stim
When checked, the spooling system stores the stimulus waveform in the initial
portion of the response waveform.  This is the default setting.  It may be changed
by selecting the highlighted Include Stim item.

#TL1703

Data Spool > Save Spool
This saves the raw data retained during a test recording to a disk file.  The default
directory for spool files is ECHOSPOO and the normal extension is MEG.

#TL1704

Data Spool > Load Spool
This loads a spool file from the current spool directory.  The data is held in memory
and does not influence the normal running of a test.  (See also Load Spool in the
Files menu).  Spooled data can be replayed through the ILO using the Replay
Spool option of the Tests menu.

#TL1705

Data Spool > Data Status
Displays the current index pointer to data held in the spool memory.  With no data
loaded, N=O and Index=32721.  N indicates approximately the number of sweeps
stored.  Each count equals 63 x 512 point waveforms.
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#TL1706

Data Spool > Auto Saving
When checked, this option ensures that a raw data spool file is saved automatically
when the results of a test are saved in the normal way.  This avoids the necessity
of using the Save Spool option and ensures that the name of the spool file is
identical to the name of the standard ILO data file.

#TL1707

Data Spool > Erase Spool
Shows a list of spool files.  On selecting a file, the option to Erase or Retain is
given.  Because spool files typically occupy a Megabyte of disc space, it is recom-
mended that spool files are deleted when no longer required to prevent your disc
from becoming full.

#TL1708

Data Spool > Part Spool
Allows for the start and end of a spool replay operation to be defined so as to avoid
portions of the recording which are of little value.

#TL17012

Data Spool > Spool DIR
Allows for the directory for spooled data to be changed.  This option is identical to
that provided for in the Directories item of the Files menu.

#TL0310

Settings > Processes
This calls a secondary menu, indicating the setting of
various internal functions and options of the ILO system.
These options cannot be changed except in the research
version of the program.  The options control the timing,
windowing and averaging functions of the ILO.  These
should not be changed for clinical uses of the instrument.
See Research Supplement for further information.

#TL0311

Settings > Q Summary
Enables a display panel shown during testing which lists the response reproducibility in
each frequency band.  Large characters are used to aid visibility.  When used in
conjunction with the automatic stop facility, bands which have attained the minimum
required value are highlighted.
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#TL0312

Settings > Band Set
Activates a secondary menu which controls the default
frequency band analysis of OAE data.  This analysis is
used to provide the band reproducibility and band
signal-to-noise figures in the right-hand display screen
panel.  For compatibility with previous versions, the
option Linear is checked by default.  We recommend
that the Half Octave option is checked.  The band
setting for the Half Octave main screen graphical
analysis (see Analysis > Band Levels) is Half Octave
by default.  This can be changed by checking the
desired Octave interval in the above menu.
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Analysis menu

The Analysis menu provides a range of utilities and processes found to be useful when
examining TEOAE data.  The menu items are only accessible when data has been
loaded or recorded and is displayed on the screen.

#TL0401

Analysis > Spectrum
#TL2401

Spectrum > Spectrum F3
Initiates a detailed response spectrum display with
cursor.  The display shows the intensity of response
and noise against frequency.  For an illustration and
detailed documentation see Data Analysis Utilities, Detailed Examination of the
TEOAE Spectrum).  The left/right and Home/End cursor keys move the spectrum
cursor and Page Up and Page Down provide course movements.  Clicking the
mouse will also move the cursor to that position.  The response and noise intensi-
ties are shown at the top of the panel, together with the frequency.  Keys F, R and
S provide alternative degrees of smoothing.

A rectangular bridge marks the band width selected for optional band limiting
(filtering).  The start and end of the filter set band width may be altered by double
clicking with the mouse, or positioning the cursor and pressing L for the lower limit
and U for the upper limit.  The key B will activate the filtering.  The filtering can be
removed if F10 is pressed immediately after closing the spectrum panel.  The
primary use of filtering is to cut out low frequency noise below 1kHz.  Narrow band
widths should be used with great caution.

Research installations have access to the phase of the TEOAE.  Press G to display
the pattern of phase change (only shown if response is greater than noise).  Shown
in black on grey are the phases of the response (RPHI), the stimulus (S5) and the
intensity of the stimulus (STB) at the cursor position.
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The cursor values can be printed or saved to file.  Pressing the key P causes the
data at the current cursor position to be sent to the printer and the cursor position
advanced one frequency point (Echoport users should ensure their unit is not
connected).  No page feed is included so the form advance button of your printer
may need to be manually operated.  The key A will result in the opening of a file
ILOFFT.TXT.   The option to enter a marker message is given.  New data is
appended to old data.  Once opened, data is written to the file for each cursor
position.  Move the cursor over the frequency region required to be documented.
The ILOFFT.TXT file is automatically terminated when the spectrum panel is
closed.

The spectrum panel can be called without a menu present by pressing the F3 key.
It can be closed by pressing the Escape key or F3 a second time, or by clicking the
mouse outside the panel.

#TL2402

Spectrum > Frequency Time
Displays the OAE as a spectrogram, showing clearly the frequencies present at
different times.  Spontaneous and near-spontaneous OAEs show as horizontal
lines on this display.  A ‘classic’ adult TEOAE has a descending frequency content
with time, seen as a sweep from top left to bottom right on the frequency time
display.  The display is useful in visualising the degree of internal reverberation in
the inner ear and for confirming if spontaneous OAEs have contributed to the
TEOAE waveform.  No clinical implications are implied by this display.

#TL0402

Analysis > Waveform
#TL3001

Waveform > Waveform F5
This introduces a moveable cursor onto the main
response panel.  The sound pressure in microPascals
is shown at the position of the cursor together with the
time of the cursor in microseconds.  The cursor
movement can be controlled with the left/right, Home
and End keys and Page Up and Page Down provide
course movements.

Relative time measurements can be made by pressing the spacebar to mark a
position of the cursor.  The time measurement will then show zero.  Movement of
the cursor will ensure the relative time between the new and old positions.

The Waveform Cursor and Windowing keystroke menu is shown above the re-
sponse panel.  A data window may be created and applied.  Key S sets the start of
the window to the cursor position.   Key R marks the end of the rise of the window
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following the start and key E marks the end of the window following a fall, as
defined by R.  Default settings are shown and key W applies the window to the
data.  The windowing can be removed if F10 is pressed immediately after closing
the Waveform Cursor window.

The waveform cursor function may be called without a menu present by pressing
the F5 key.  The function can be ended without changing the data by pressing the
Enter key or by clicking outside the keystroke panel.

For illustration and further discussion, see OAE waveform in Data Analysis
Utilities.

#TL3002

Waveform > Profile F6
Underlays the waveform display with its power profile.  This is the correlated
(possibly response) power.  Noisy traces will have a lower energy profile than clean
traces.  In a clean response, the profile will follow the envelope of the waveform,
passing 30% below the peaks and thus representing the sound pressure level, not
peak level.  This requires that the two waveforms, A and B, are in phase.  (The two
waveforms are multiplied together, smoothed over 5 points and square rooted.  The
RMS sound pressure is shown.)  Pure noise will in general have a profile much
lower than the waveform.  There may be power peaks by change coincidence, but
these will generally not be at the peaks of the waveform.

The display is useful to visualise the times when energy is arriving and in under-
standing why a large (noisy) trace is not valid as an OAE.

#TL3003

Waveform > Gating shF6
Displays the envelope of the gating window used in processing the current data
(white) together with the mean waveform (A+B)/2.

It is important to remember that the accuracy of the frequency analysis applied to
the waveform requires the beginning and end of the recorded waveform to be
faded out.  This means that frequency components only present at the start (e.g.
the highest frequencies) may be lost.

Re-windowing may be useful.  Note that previously gated-out data in saved data is
not usually recoverable.

#TL3004

Waveform > Reveal AB F2
The two independently collected TEOAEs, A and B, are normally superimposed on
the Response Display.  This option separates the two waveforms so that areas of
difference and similarity can be examined visually.
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#TL3005

Waveform > A-B wave F4
The two independently collected TEOAEs, A and B, are normally superimposed on
the Response Display.  This option displays the differences between waveforms A
and B.  Differences are quantified in the ‘noise’ (red) component of the OAE FFT
spectrum.  The difference display is useful only in showing where in the waveform
difference occurred.

#TL3006

Waveform > Delay Shift
This function is intended only for use when two different files are being compared.
Delay Shift allows a correction to be applied for any time difference between two
recordings.  This might occur as a result of different probe insertion depths, or seal
qualities.  The left and right cursor keys introduce a relative time shift between
traces A and B.  This is relevant when comparing traces recorded on different
occasions from the same ear.  Ear canal fit changes can be corrected for, but only
in limited frequency ranges.  Time shift should be adjusted so as to maximise
reproducibility in that band.  This is displayed as a conversion of red spectrum data
to blue spectrum data in the Response FFT.  We recommend you gain experience
by introducing a delay into a single recalled measurement first for comparison.

The delay introduced between A and B response traces is shown in the top of the
Response panel in milliseconds.  The function is ended by pressing the Escape or
Enter keys.  The final delay is shown.

#TL3007

Waveform > Zero Delay
Cancels any delay introduced with the previous option.

#TL0403

Analysis > Progress
Progress displays the history of important parameters during the course of recording,
for technical test evaluation purposes.  Use this display to decide on the reasons for a
test failure.  The panel shows graphs of reproducibility, stimulus stability, stimulus level
and noise level at intervals during the testing.  Reproducibility should grow steadily
during a good test; stability should remain high and stimulus dB should be steady.
Noise level may show fluctuations with a noisy patient.  Good test results with poor
stimulus indicated at the end of the test may be accepted if the progress chart shows
stimulus decline to be limited to the very end of the test.

The Progress panel may be called without any menus present by pressing the P key.
The panel can be closed by pressing P a second time, or by pressing the key C (clear).

For illustration and further discussion, see Test progress in Data Analysis Utilities.
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#TL0404

Analysis > Statistics
Initiates a secondary menu, providing a range of statisti-
cal tools with which to analyse the data.  These are of two
types.  The first group utilises raw data saved during a
recording and reprocesses the data using advanced
procedures.  This is shown shaded if not in use.  The
second group does not require advanced statistical
processing.  It compares the currently displayed response
data with normative data held on file to produce an
assessment of the response.  For further details, see
Use of the ILO Statistical Analyser.

#TL2201

Statistics > View Spool
When the raw data spool contains data, this option displays data from each sweep
and its spectrum, one by one, making a movie of the data sequence.  This is useful
in identifying good and bad sections of the recording for reprocessing.  With strong
TEOAEs, each sweep can contain a recognisable OAE.

#TL2202

Statistics > Reconstruct
Reprocesses the raw data from the spool (if loaded).  Reject level can be preset.  A
probability assessment is made for each band.

#TL2203

Statistics > Super Reject
Reprocesses the raw data from the spool (if loaded).  Rejection is on a band by
band basis - making maximum use of available data.  A probability assessment is
made for each band.

#TL2204

Statistics > Half Octave Mode
For use only with spool reprocessing.  When checked, the probability assessment
in Reconstruct and Super Reject is in Half Octave bands, otherwise it is in 12
harmonic bands (800Hz for Quickscreen data).

#TL2209

Statistics > 88-Analysis
Provides the popular Version2 ILO88 program, ‘Analysis’, which can load a number
of TEOAE files and display them in various forms.
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#TL2210

Statistics > OAE Stats
Provides the simple Version4 ILO88 ‘OtoEmissionGram’, which gives a rough
assessment of validity in band reproducibility.  If an ILO normative stats file is
loaded, the percentile rating of the OAE is shown relative to the population stats.

#TL2211

Statistics > Load Stats
Loads normative data as produced by ILOSTATS, for use by OAE stats.

#TL2212

Statistics > ILO Stats
Provides a link to the ILOSTAT utility which can process up to 1,000 ILO88 data
files and generate statistical summaries.

#TL0405

Analysis > Band Levels
Band Levels switches to dual screen if not already set.  It provides an analysis of the
OAE signal in half-octave bands (default).  Resolution can be changed during the
display by pressing 1 through 8 for one octave through to one-eighth octave band-
widths.  If the screen is in the normal display mode, the analysis is shown as a histo-
gram against the background noise.  If the display screen is rearranged to dual mode
(keystroke R), the analysis is shown as a linear graph with numerical values to the
right.  The default analysis resolution for the session can be changed using the
Settings menu Bandset option.

In the standard display form, the analysis panel can be called without menus present
by pressing the key H.  The panel can be closed by pressing H a second time, or C to
clear, or W for waveform display.  The display is also cleared when a new recording
takes place, but may be requested during a recording with the H key.

In the dual screen mode, the band analysis panel is retained during subsequent
recordings and is refreshed along with the rest of the screen.  Dual screen mode is
cancelled by pressing the R key.  The resolution of the display is as set in Settings >
Band Set.

#TL0406

Analysis > Half Octave
This displays a half octave analysis of the response, independently of the current band
setting.  The display takes the form of a histogram.  Resolution can be changed using
keys 1 through 8.
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#TL0409

Analysis > Compare Merge
Comparison allows the selection of a second data file to overlay the resident file.  The
review panel is displayed and the file loaded in the usual way.  The two files must be of
identical response types, e.g. both QuickScreen, in order for the comparison to be
meaningful.  The newly loaded file appears on the display screen together with the
previously loaded file.  In particular, the response waveforms of the two files are
overlaid and can be compared.  The contents of the two files are correlated.  A correla-
tion (e.g. reproducibility greater than zero) indicates a degree of identity between the
two recordings.  This can occur over the whole frequency range or over limited parts
only.  In the Response FFT display, the differences between the responses are shown
in red and the co-related response components are shown in blue.  Unlike the display
of a single file, the red spectrum portions do not necessarily indicate noise, but a
combination of the noise present and the differences between the responses.  Re-
sponses differing in amplitude but not waveform will exhibit substantial ‘noise’ due to
the differences between them on subtraction.  Responses of identical waveform but
shifted in time relative to each other will also show a high ‘noise’ level.  This may
indicate probe fitting differences.  Time delays can be corrected using the Delay Shift
function above.

#TL0410

Analysis > View & Score
This enters the ILO Score Mode.  The scoring toolbar is displayed at the top of the
screen.  The test is  rated as either PASS, REFER or INVALID.  The selected rating is
highlighted and confirmed with the Enter key.  A request for the scorer’s ID appears
(signature) and when entered, the files for the other ear of the patient appear in the
Review panel.  It is possible to mark a pass as doubtful before signing off the file by
pressing the Q key.  The file can be rescored before signature by pressing the Escape
key.  It is possible to perform other analyses on the data while in the score mode by
selecting the View Data button, or pressing the V key.  The normal analysis menu is
then accessible.  To return to the score mode, select the Score Mode button  with the
mouse.  Score mode may be terminated by selecting the Quit Score button, or press-
ing the Q key.  This retains the scores on the scoring data file but abandons the
function which renames the data files (see below).  It is not possible to quit between
left and right ear scoring.

The rating will be marked onto the extension of the file name (e.g. before scoring .DTA,
pass is .DTP, refer is .DTR, invalid is .DTI and doubtful pass is .DTQ).  Scored files are
copied to a file list by the name of SCORED.LST to be found in the ECHOPROG
directory.  This list can be used by the Back Up utility in the main ILO-V5 option box
screen after exiting from the ILO test program.
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#TL0411

Analysis > Terminator
Re-examines the current data against the current Stop Logic protocol and indicates the
primary condition which would have led to termination of the test recorded under that
protocol.  This process can be used to apply a standard pass criteria to previously
recorded data.

Options menu

#TL0501

Options > Desktop Set
Provides for rearrangement of the display screen, saving
and loading customised arrangements.  To customise the
arrangement of your desktop, select Arrange Desk either
from the secondary menu or from the Options menu.  The
user may modify the desktop using the mouse.  The
toolbar is automatically removed.  The individual display
panels may be moved and changed in size as desired.
The desktop may then be saved (S) or loaded (L) or made
the default for future sessions (M).  To move a panel, hold
down the left mouse button on the centre of the panel.  To
change the size of the panel, hold down the right mouse
button on the edge of the panel.

If the arrangement of the display has been changed using the Arrange option, it may
be restored by pressing the Z key.  The Z key does not change the overall size of the
desktop.
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#TL0503

Options > Hide Tool Bar
Removes the toolbar and restores the Escape menu system of the original ILO88,
described elsewhere.  The mouse becomes active to rearrange the desktop.  Key Z
will restore the default desktop format.  Pressing Z whilst holding the left mouse button
will enlarge a panel to full screen.  The toolbar may be restored by pressing Alt+F.

#TL0504

Options > Sound Prompt
Turns on and off the ILO audible prompts.  When on, the option is checked (4).

#TL0505

Options > Training
If connected, the ILO hardware is disabled and test recording is conducted using
synthesized signals.  This option is used only for training and should not be employed
during clinical recordings.  All recordings made with this option are identified as
training recordings.

#TL0506

Options > Old ILO 88
Removes the toolbar and restores the Escape menu system of the original ILO88,
described elsewhere.  The mouse becomes active to rearrange the desktop.  Key Z
will restore the default desktop format.  Pressing Z whilst holding the left mouse button
will enlarge a panel to full screen.  The toolbar may be restored by pressing Alt+F.
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View menu

#TL0601

View > Clear Screen C
Refreshes the display screen and removes temporary panels.  The Clear Screen
function can be called without menus by pressing the C key.  The Z key performs a
more powerful reset of the display.

#TL0602

View > Normal View N
Restores the standard ILO88 waveform display format.

#TL0603

View > Dual View R
Provides a split screen.  The upper screen contains the standard OAE response
panels.  The lower screen contains a half (or alternative) octave frequency analysis of
the TEOAE.  If the DPOAE software is visited, the DPOAE response recorded will be
superimposed on the TEOAE half-octave analysis in the lower panel.  If the key Y is
pressed, the current display is copied to the lower half and held so that other data may
be recalled and compared with the stored data on screen.

The Dual Screen can be accessed without menus visible by pressing the R key
(rearrange).  Pressing the R key a second time restores the single screen mode.

#TL0604

View > Copy Down Y
Copy Down utilises the dual screen format, which is automatically set if not already
activated.  The active display is copied to the lower half of the screen; work may then
proceed on the upper half and the results may be compared to the original data below.
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The Copy Down function may be accessed without menu showing.  Press the Y key to
copy the active display to the lower half of the screen.

#TL0605

View > Quad View Q
Redraws the current screen in reduced format four times.  Work can be conducted on
any one of the four panels.  The active panel can be selected by clicking with the
mouse on the panel.  On normal VGA, the resolution available does not allow for
perfect representation of the data.  The feature is of use for comparison of recordings.
The Quad View can be terminated by selecting the menu option a second time, or by
performing a Display Reset (key Z).

#TL0606

View > Scale Wave
Magnifies or reduces the displayed image for inspection purposes.  A permanent
expansion or reduction may be applied by pressing the * key.

#TL0607

View > Reveal AB F2
Separates the two overlaid traces recorded alternately during the test so underlying
similarities or differences can be seen more clearly.   Duplicates the action of the F2
key.

#TL0608

View > Expand Response
Stretches the timescale by four times to allow detailed aspects of the waveform to be
examined.  To move the observation window left and right, use left and right cursors.

TL0609

View > Longer Stim
Displays the full waveform of stimulus waveforms which exceed the length of the
standard stimulus window.  This might arise if you use a customised tone burst
stimulus of a low frequency.  The option is only available if you accepted the option to
modify the recording window which is presented at the time of stimulus construction.
Custom stimuli are constructed using the Stimulus sub-menu Waveform option in
research capable installations.  Extended tone burst stimuli can also be selected in
regular installations from the Test menu Tone Burst option.  Selection of a low
frequency tone burst stimulus automatically reduces the time window available for
response recording.
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#TL0610

View > Colours
Selects the palette used for screen display.  The user
may select black on white, or white on black, which are
more suitable for some printing and photographic
operations.  Various colour palettes are supplied which
may be preferred with specific colour printers.

The Background option switches the grey background
of the ILO screen to black.  Second selection restores
the grey.  This can be useful with some printers.
Colour selections are not cleared by either the Z or C
screen clear functions.

To restore normal ILO screen colours, select View > Colours > Standard.

#TL0611

View > Image Save
Saves an image of the current screen on a file.  This function can be accessed at any
time without the menu by pressing Ctrl+U.

#TL0612

View > View PCX
Allows a saved image to be recalled and displayed on the screen.
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Memory menu

The ILO has five test response memories.  One is the active response memory holding
the data displayed on the screen.  There are four other reserve response memories
which can be recalled to the screen.  When a new recording is made, it is placed both
on the screen and in the first of the four other memories.  Previously stored responses
are shifted along in the memory.  The memory can therefore hold the last four standard
recordings.  Spontaneous emission recordings occupy the whole of the memory
available.

The memory menu helps to manage the ILO memory.

#TL0701

Memory > Get Memory
This displays the contents of the four reserve memories in the quad display format.
Top left is Memory 1, with Memories 2, 3 and 4 displayed clockwise.  A reserve
memory can be selected and displayed on the screen by keying in its number, 1-4, or
clicking on it with the mouse.  Selection can be abandoned by pressing Escape, when
the previous display will be redrawn.

#TL0702

Memory > Arrange Memory
This displays graphical summaries of the four reserve memories in sequence across
the screen.  Any Memory 3-4 can be brought forward to position 1 by keying in its
number.  Memory 4 is lost each time a new recording is made.  A secondary use of this
display is to observe the time course of response during an SOAE recording which
spans four memory regions.
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#TL0703

Memory > Series Memory
This displays the four reserve memories in a special ILO format which allows for the
detailed response waveforms to be compared.  The Response FFT for each waveform
is also displayed across the top of the screen.  The stimulus waveform for each
memory can be substituted for the Response FFT and vice versa by clicking in the
upper part of the display.  Press Escape to clear the display.

#TL0704

Memory > Combine Memory
This displays the four reserve memories in quad display format, as in Get Memory
above.  It is then possible to enter a numerical formula, e.g. 1+2-4, to specify a combi-
nation of responses to be displayed and transferred to the active memory for analysis.
One application is to subtract two repeat recordings in order to define the differences;
another is to add together repeat recordings in order to obtain an improved average.
Note that the arithmetic is applied literally.  The result of 1+2 will not be the average of
responses 1 and 2, but the sum.  It will therefore be necessary to use the Scale Wave
function of the View menu to produce a true average, by dividing by 2.

#TL0705

Memory > Put in Memory
This enables the active screen to be stored in memory position 1, displacing existing
memories by one position.

#TL0706

Memory > Extract Raw
This displays the un-windowed version of the current active memory, where available.
It is normally only available for freshly recorded data (not recalled data).

#TL0712

Memory > Save Spool
This saves the raw data retained during a test recording to a disk file.  The default
directory for spool files is ECHOSPOO and the normal extension is MEG.
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Key Macro menu

This menu allows for automatic operation of menu sequences, according to pre-
recorded macro programs.  This is helpful in setting up user preferences and in
accomplishing a series of measurements automatically.

A single macro program can hold approximately 30 instructions comprising up to 100
characters.  Macro programs can call each other.  They are saved in groups of ten,
identified by number, 1 through 10.  Each macro can also be named.

#TL0801

Key Macro > Run
This initiates the macro program.  If a program has been previously picked using the
Pick option, it will commence running immediately.  If not, the desired program number
must first be selected.  Any key will interrupt the program.  The Program Pause
keystroke menu is displayed.  The Enter key will continue the program; key B breaks
the program at that point (the program may then be continued by selecting the Con-
tinue item in the Key Macro menu).  Keys L and R set the left and right ear respectively
in the Patient ID panel and key N allows the entry of a new patient name.  Run can
also be activated using Ctrl+F4.

#TL0802

Key Macro > Pick
Pick lists the available programs by number and name.  The highlighted program is
selected by clicking with the mouse or pressing Enter.  This program will be automati-
cally selected when the Run command is given.  When a macro program has been
picked, its number is shown opposite the Run command.

#TL0803

Key Macro > Continue
Continues an interrupted keystroke program.
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#TL0804

Key Macro > Learn
This sets the ILO into Learn mode.  Every keystroke is recorded into the selected
macro program memory.  The mouse is not operational during learning.  All menus
may be operated using the cursor keys, underscored keys and the Enter key.  All other
operations of the ILO remain the same.  As recording progresses, the macro index
number 1 through 99, is shown top right.  To terminate the program, press Ctrl+F3.
This corresponds to the Finish menu item below.  When programming a test recording,
it is not necessary to perform an actual test.  Ctrl+F8 will request a test without it being
actually initiated at that time.  The program may call anothother program previously
prepared.  Press Ctrl+F4.  The option to run the second macro at that time, or not, will
be given.

#TL0805

Key Macro > Finish
This terminates the learning mode.  It is preferable to terminate the learning mode
using the Ctrl+F3 key operation to avoid learning the steps to highlight the Finish item.

#TL0807

Key Macro > Edit
The macro number is first selected.  The macro program listing menu is displayed.  L
lists the actual keystrokes pressed.  Key I allows for the insertion of a new command;
key D deletes a command and key E ends the listing function.  List function can also
be accessed by Ctrl+F7.

#TL0810

Key Macro > Store
This saves the current set of ten macros to a named disk file.  This function can also
be accessed by Ctrl+F5.

#TL0811

Key Macro > Get
This gets a set of macros from a named disk file.

#TL0812

Key Macro > Slow Speed
Macros normally run faster than keystrokes can be entered manually and it is difficult
to see what they are doing.  If the slow speed option is checked (4), the macro
operation is slowed down so that it may be reviewed.  The slow speed option remains
active until Slow Speed is checked for the second time.
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Information menu

#TL0901

Information > Version
Shows the software version, together with the number and compilation date of the
specific release.  This should be quoted when reporting problems with the program.

#TL0902

Information > Licensed to
Gives the serial number and registered location or ownership of the ILO system to
which the software belongs.

#TL0903

Information > Probe Check
This displays the currently registered probe identification and the number of tests
performed under that probe ID.  The number of tests which will trigger the calibration
reminder is also shown.  A keystroke option S is provided.

On pressing S, the option of making a service disk is given.  The history of a current
probe is written to a floppy disk (provided by the user) and should be sent with the
probe in the case of a warranty claim or service request.

#TL0904

Information > F Keys
This displays a summary of the keystroke shortcuts to some ILO functions.  These are
identical to those in Version3 and 4 ILO software.  Press Escape and then F1 to clear.
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#TL0905

Information > Hot Keys
This displays the functions of various keystroke shortcuts to some ILO functions when
operating the ILO in the original mode (without mouse operated menus).   The func-
tions are identical to those in Version3 and 4 ILO software.  They are included for
compatibility with earlier versions but Otodynamics reserves the right to withdraw hot
key functions in future versions.

#TL0909

Information > Menu Display
This shows a gallery of all available mouse operated menus with their corresponding
reference numbers and names.  There are two pages; the second page is accessed by
the Enter key.  It is possible to save the screens in PCX format by pressing Ctrl+U.

#TL0910

Information > Write Menus
Allows the text of every menu to be copied to a file.

#TL0911

Information > Read Menus
Allows the entire text of the menu system to be replaced for the purpose of language
translation.  Please contact Otodynamics with requests for alternative menu lan-
guages.  Otodynamics cannot guarantee to meet every request.

#TL0912

Information > Service Code
Allows Otodynamics service engineers to obtain technical information about your
system.  You may be asked to access this function if you report a fault by telephone
and enter specific service codes.
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PART THREE
DPOAE User Manual
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DPOAE functions of ILO V5 software

What are DPOAEs?
DPOAEs are part of the normal
process of otoacoustic emission
by the cochlea.  They are the
part that does not totally reflect
the stimulus presented to the
cochlea - hence the name
Distortion Product.  No biological
system responds precisely to the
exact form of the stimulus and
this is true of the ear.  A distorted
response is also called a non-
linear response.  The ILO88
typically records the non-linear
part of the otoacoustic emission
response to a click stimulus,
because this helps identify the
biological nature of the response and eliminate artefacts.

DPOAEs are the non-linear part of the otoacoustic emission to a pair of tones.  A pair
of tones is used instead of a click stimulus as this makes it technically easy to extract
the distortion OAE.

The figure above shows a DP-Gram which represents the level of distorting otoacous-
tic emission activity at a series of frequencies.

Are DPOAEs the same as click OAEs?
Essentially yes, but the technology is different and each technology has its own
practical advantages and disadvantages.

Click or transient evoked non-linear OAEs (TEOAE) are most sensitive to cochlear loss
because the recording is made during the silence between the clicks. Unfortunately,
high frequency TEOAEs emerge very quickly and are lost in the stimulus portion of the
recording.
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The DPOAE method does not depend
on the time delay of OAE for its
detection, so the technique is effective
up to higher frequencies. The method
is valuable in clinical screening.
Higher levels of stimulation are needed
to keep recording times short, because
each frequency band has to be
measured separately. This means that
the DPOAE method is a little less
sensitive to slight cochlear disorder
leading to only 10-20dB hearing loss.

The combination of TEOAE followed by
DPOAE provides a comprehensive view of cochlear status not afforded by either
technique on its own viz. high sensitivity, speed and high frequency effectiveness.

DPOAEs also have a delay like TEOAEs and this can be tested to ensure it’s greater
than 2.5ms - as in the TEOAE method.

The figure above shows a TEOAE recording and DPOAE recording compared on the
same screen.

Starting DPOAEs from the TEOAE screen
DPOAE recordings can be initiated from the Tests
menu of the ILO88 program.  Please see the Tests
menu for details.  Alternatively,
DPOAEs can be called from
the opening Options screen by
clicking on the DPOAE button.
Immediate transfer from DPs
back to TEOAEs can be
achieved with the T key and
from TEOAEs to DPs with the D key.
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Overview of the DPOAE menus

On starting up the ILO88DP Distortion Product program, either from the opening
selection box screen or transferring from the ILO88 screen, you will see five icons on
the top left of the screen.

From top to bottom, these are:

i
Information button

Menu
This activates the tool bar from which many other menus are
accessible.  The tool bar can be activated with the mouse or by
pressing M on the keyboard.

DP-Gram (F6)
The icon provides a shortcut to the measurement of DPOAEs as a
function of frequency.  It can be activated with the mouse or by
pressing the function key F6.

DP Spectrum (F7)
This provides a shortcut to the measurement of Distortion Product generation at a
specific stimulus frequency.  It may be activated by the mouse or by pressing the
function key F7.

Transient OAE (T)
This provides a shortcut to the ILO88 TEOAE functions.  This may be activated with
the mouse or by pressing the key T.

NB: Icons present on the ILO88DP screen are activated by a single press of the
mouse button.
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The ILO88 DPOAE toolbar

On pressing the menu icon, or the key M, the tool bar will appear, as shown above.  To
access any of these menus, either press the highlighted letter on the keyboard  or click
once on the topic with the mouse.

Files menu

Files > Load data file
This function allows stored recordings to be retrieved and analysed.  On selecting this
option, a list of file types is displayed, together with the number of files of that type
stored on the current directory.  The file types on the ILO88DP are DP-Gram and DP-
Spectrum.  Selecting the file type provides a directory listing of the files, together with a
graphical summary of the data contained.  Selection of the file name results in the file
being loaded and displayed on the screen.

To abort any selection, press the Esc key to return to the main tool bar.

Files > Save date file
This function provides for the saving to disk of recorded data.  It is mandatory for the
patient’s name and ID to be entered before saving.  The file name is constructed from
the patient’s name, together with a serial number.

Files > Enter patient ID
This allows the patient’s name and hospital ID to be entered prior to recording or
saving the DPOAE data.
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Files > Read directory
This provides an immediate display of
all the files held on the current data
directory.  There is provision for
sorting and selecting sections of this
file list.

Files > Default directory
This allows for the data directory to be
renamed in order to access other data
stores.  The directory entered here is
automatically reinstated when the
program is next called.

Files > Print
Print will provide a graphical print of the displayed data on the pre-selected printer.

Files > Printer Setup
This allows for your printer to be identified for future print operations.

Files > Exit
This terminates the DPOAE program and returns the user to the main software
selection box screen.
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Test select

Test Select > DP-Gram
This is the main measurement
function of the ILO88DP DPOAE
system.  The stimulus frequency pair
(f1&f2) are automatically swept across
the frequency range 1,000-6,000Hz
and the resolution (interval between
steps) may be pre-selected to be from
one octave to one-eighth of an octave.
There is also the possibility to zoom in
to limited frequency ranges to provide
a more detailed view of the DPOAE
response.  The default protocol is for cyclic repetition of all measurements with averag-
ing of results.  Please see the detailed instructions on DP-Gram operation later in this
manual.

Test Select > Transient echo
Activation of this menu item will transfer directly to the ILO88 program.  The data
recorded on the DPOAE section of the program is retained and can be returned to at
any time by pressing the key D from the ILO88 program.  In this way, DP and TEOAE
responses can be quickly compared.

Test Select > Point Spectrum
When Point Spectrum is acti-
vated, the stimulus tones are pre-
selected and there is no automatic
sweep.  Instead, the DPOAE
recorded is displayed, together
with other signal and noise
components whilst averaging
continues.  Please see more
detailed instructions following.
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Test Select > Latency check
When this item is checked, the ILO88DP will automatically perform a latency check on
the DP being measured and will alert the user to unusually low latency by changing the
colour and the point format of the data at that frequency.  Otoacoustic emissions have
a characteristic latency.  OAEs of latencies smaller than 2.5ms would not have regis-
tered on the ILO88 Transient system and therefore should be confirmed as not being
due to an artefact.  Please see additional instructions in the detailed DP-Gram user
section below.

Test Select > Growth check
When this item is checked, the ILO DP system automatically performs a DP measure-
ment at two levels of stimulation 10dB apart (optionally 6dB).  DPOAE responses
normally grow steadily between stimulus levels, typically at around 1dB increase for
1dB increase in stimulation.  If the ILO DP detects a gradient steeper than 2dB/dB, the
user is alerted by changing colour and point format on the data at that specific fre-
quency.  Since rapid growth can be an indication of artefactual distortion generation,
the user is recommended to confirm this data point.  Steep DPOAE gradients can
occasionally arise from natural causes within the cochlea, such as phase cancellation.
Such events happen only at very specific frequencies and levels and are of no clinical
significance.  However, it is recommended that the presence of true DPOAEs is
confirmed at adjacent frequencies.

Test Select > Latency
When this item is checked, the ILO DP system automatically performs a latency
measurement on the DPOAE by measuring its phase for two slightly different frequen-
cies a few tens of Hz apart.  The DPOAE response normally takes from 2 to 10ms to
emerge and this is revealed by the gradient of phase between the two frequency
products.  If the latency is smaller than 2ms or smaller than the normal range for the
frequency being observed, this must cast doubt on the physiological origin of the
DPOAE.  DPOAEs observed at high levels are more likely to suffer contamination from
probe distortions than those collected at low levels.
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Setup menu

Setup > Load parameters
This provides for the loading of a file
from disk which contains specific
settings of the stimulus conditions to
be used for the DP measurement,
e.g. the ratio of frequencies and
amplitudes.

Setup > Save parameters
This allows the current stimulus
parameters to be saved to a disk file.
The disk file can either have a name
of the user’s choice, or be identified
as a start-up file.  In the latter case,
when the system is next used, the
parameter file will automatically be loaded.  Please see below for the content of the
parameter file.

Setup > Test param menu
This item allows for the adjustment of the
intensities and frequency ratios of the
stimulus tones.  This is achieved by the
cursors and the tab key (or the mouse) to
identify the item to be changed.  Please
see the detailed section on DPOAE
measurements with the ILO88DP for
further information on the choice of
parameters.
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Setup > Adopt loaded file params
This option only appears once a data file has been loaded.  Adopt loaded file params
transfers the parameters which were used on the displayed DPOAE measurements to
become the current test parameters for the next test.  This is useful when the previous
recording of the patient has been recalled and it is desired to repeat the measurement
using the same parameters.  In this case, the parameters from the recalled data are
adopted.

Analysis menu

The analysis menu provides a means of observing the DPOAE data more closely.

Analysis > Graphical analysis

This item displays the current DPOAE data and allows for its inspection.  In particular,
a specific point may be highlighted and the conditions pertaining to the measurement
at that point are displayed, e.g. length of time used to record the point, noise level and
actual stimulus conditions for that point.
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Analysis > Numerical analysis

This option displays the data collected in numerical form on the screen.  This numeri-
cal data can be printed or, alternatively, transferred to database format for later analy-
sis.

Analysis > Calibration Tones
Calibration Tones provides for the setting of two frequencies to be applied continu-
ously to the probe so that they may be measured by external calibration equipment.
The frequencies are adjusted after pressing T for F1 and O for F2.  Either tone may be
turned on or off.  On pressing the Enter key a real-time display of sounds detected by
the microphone is shown.  The level of each tone may be set using the up/down cursor
keys for F1 and the + and - keys for F2.  The internally derived measure of sound level
should be compared with that from the external measuring equipment.
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Configuration menu

Configuration > Probe menu
This allows for the calibration of OAE
probes, the saving of this calibration data
and its recall.  Probe calibration data is
used to compensate for differences be-
tween probes and sound level measure-
ments during the test.

Configuration > VDU type
This allows for the selection of the
screen resolution in use.

Configuration > Screen Colours
Screen Colours provide the options
of halftone, black and white or full
colour graphic displays.

Configuration > Demonstration mode
This option allows the software to be
run without hardware present.  This is
useful for reviewing data on another
PC.  Once this item is checked and
the program closed, the program will
reopen in the demonstration mode
and therefore will not access the
hardware or make recordings.
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Configuration > Program operation
This provides options relating to the
display of data and its collection.
These are:
(a) The graphical highlighting of

DPOAE frequencies for easy
identification.

(b) Implementation of probe re-
sponse compensation, according
to a loaded calibration file.

(c) Implementation of noise rejection based on its level.
(d) Use of high precision frequency analysis (FFT), maximising precision and signal-to-

noise for the fastest PCs only.

Configuration > Advanced operation
These options are applicable to
research uses of the ILO DP system
and are fully documented in the DP
Research Software Guide.
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Configuration > Environment/Preferences
This provides a range of options
relating to the PC and the user
interface of the program.  These
options include:
(a) The use of EMS computer

memory, if available, to enhance
speed.

(b) The use of icons to display
shortcuts to functions.

(c) Full or limited menu options to
remove setup functions from the
user’s screen.

(d) Sort Data File Directory determines the order of files displayed on directory func-
tions.

(e) Display Data File Summary activates the graphical summary during directory
review.

(f) Auto Noise Reject Mode provides an automatic limit to the amount of noise toler-
ated before recording.

(g) Percentage Reject Level provides the base line for the automatic noise reject level.
(h) Windows Style Menus determines the order of the tool bar as it appears on the

screen.
(i) Flush Smart Drive Each Take complements the disk caching utility of your compu-

ter by ensuring that data will not be lost when the program is closed or the compu-
ter is switched off.

(j) Normative Data Display - when checked, the program looks for a user supplied file
containing the limits of normal DP levels appropriate to the local protocol adopted.

Configuration > Load configuration
This loads from disk previously saved environment/preferences selection.

Configuration > Save configuration
This saves to disk the current environment/preferences options selected.



Issue 5a  : October 1997 ILO OAE Instrument User Manual 3-15

Help menu

Help > General Help
This function provides a simplified online manual to guide users through the use of the
controls of the program.
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Help > Function key Help
This provides a summary of the shortcuts to important functions via function keys.

Help > About
This identifies the version and origin of the program currently being used, followed by
user support contact information.
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Making and interpreting DPOAE
measurements

Indications for use
Both TEOAEs and DPOAEs are useful as screening tests for cochlear function in
infants, children and adults.  They are particularly useful when the patient is unable to
respond.

DPOAEs are particularly useful with older patients, as the method can tolerate sub-
clinical depression of cochlear activity.  DPOAEs are also of use to test the higher
frequency region of the cochlea.

The absence of DPOAEs may indicate sensory or middle ear pathology.  This should
be investigated with tympanometry.  The presence of DPOAEs with hearing loss does
not prove a retro-cochlear function but is consistent with this.  Electro-physiological
confirmation of auditory function should be undertaken in cases where there is risk of
neurological involvement, e.g. following serious jaundice in newborns.  In general,
infants with known risk factors for hearing impairment should receive both OAE and
ABR tests.

The most common application of OAEs is in the routine screening of newborns to
confirm normal peripheral auditory function.

OAEs have proved useful in establishing the site of lesion.  For example, they have
been used to detect cochlear dysfunction associated with eighth nerve tumours and to
detect cochlear dysfunction accompanying meningitis.  They have also proved useful
in detecting cases of hearing loss in children, when it is of purely retro-cochlear origin.
In these cases, the provision of acoustic amplification often needs  to be re-examined.

Presence of true DPOAE activity means some degree of normal cochlear function is
present at that frequency.  Missing DPOAE over at least one-third octave indicates
further investigation is needed.  Middle ear as well as cochlear pathology can block
DPOAEs.

No precise relation to threshold of hearing has been determined.  The dB level of
DPOAE is not clinically significant.  The ILO88 with DPs is still a screening instrument.
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Calibration
The test program should first be run and, if completed satisfactorily, this confirms that
the internal circuit is working correctly.  This test automatically confirms that the correct
amplification is present in each section of the system.

The test program does not perform tests on the OAE probe.  This is performed using
the ILO88 OAE measurement program.

Probe condition
The probe to be tested is fitted into the probe socket and the TEOAE program started.
The probe is fitted into the 1cc acoustic calibration cavity.  A Checkfit can be performed
at this stage as if beginning a patient measurement.  On closing the Checkfit process,
select the Probe test option from the Collection menu.  Confirm the type of probe
being tested and continue with the test.  The probe test injects an artificial OAE which
is recorded on the screen as a series of three oscillatory tone bursts at 700, 2,000 and
4,000 Hz respectively.

A typical probe response is shown below.
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A copy of the probe test performed at the time of manufacture accompanies every
probe.  We recommend that you perform and print a probe test on your equipment on
first receiving the probe and retain this for later comparison.  Substantial changes
(>3dB) on any tone burst may indicate contamination of the sound tubes, deterioration
of the probe transducers or incorrect fitting into the test cavity.  If, on cleaning the
probe and properly fitting it into the cavity, substantial deterioration of performance is
seen, the probe should be replaced.  Contamination typically reduces the higher
frequencies first, loose coupling to the test cavity can reduce the low frequency
response and may artificially enhance the middle frequency response.

While the above test is useful, it is unable to distinguish between changes in the
performance of the microphone and the loudspeaker.  An independent external
calibration should be performed at least annually when your ILO292 DP Echoport is
serviced, or at any time.

Two methods are provided for externally validated calibration of the ILO sensitivity - a
quick check and a detailed check.  In both cases, the DP Echoport itself is used as a
sound analyser and known sounds are presented to the instrument via the acoustic
probe.

In the quick method, the probe should be placed in a known sound field of 84dBspl
(0.1N/m2) at 1kHz.  Such a field may be obtained from a hearing aid test system or,
alternatively, with the use of a freefield audiometer.  In the latter case, a sound level
meter is needed to set the sound field to 84dBspl.  This should be set with the OAE
probe already in position next to the sound level meter microphone.  Care should be
taken that no movement of personnel in the room occurs during the subsequent
measurement.

With the external sound field applied, and with the software performing the Checkfit
process, the stimulus window should show a sine wave peaking at +/- 0.33Pa.  This
level is marked by check marks on the side of the stimulus window box.  Production
tolerance allows for a +/- 2dB variation in probe performance which equates to a +/-
20% deviation from the calibration marks.  If absolute calibration of OAE levels are
required, a small correction can be computed from the actual level shown in the
stimulus window.  It should be noted that the microphone sensitivity may change with
frequency and it may be required to repeat this test at higher frequencies.

For a thorough analysis of the ILO acoustic sensitivity through any probe, the detailed
calibration options should be selected.  With this option, the ILO screen shows a
spectrum analyser display which records all sounds presented to the probe.  The
provision of an external sinusoidal tone will result in a peak appearing at the appropri-
ate frequency on the ILO screen.  The nominal intensity of the sound according to the
present calibration will appear above the peak detected.  On pressing the space bar,
the user is able to enter the true sound pressure level as indicated by their own
acoustic instrumentation.  On pressing Enter, this value is saved in a file against the
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identity of that particular probe.  A series of frequencies can then be applied and the
calibration entered and this data will then be recorded for later use.  It is recommended
that at least one point of calibration is made for every third of an octave of frequency,
or a greater number of points if possible.  The dead file can be accessed whenever
that particular probe is re-inserted into the instrument and absolute calibration of the
acoustic measurements made by applying a correction.

NB: This detailed procedure is effective only when used with a probe which has
integral electronic ID.  The accuracy of this process is limited to the accuracy of
the acoustic measurement of the sound field supplied to the probe.  The use of
the ILO system for clinical screening purposes is not critically dependent upon the
absolute calibration of the instrument.  This is a screening device used to detect
rather than to measure cochlear activity.  For research purposes, the above
procedure may be important.  For general screening use, the quick test will be
sufficient to ensure that correct screening results are obtained from the ILO
system.

Mouse operation
The ILO software recognises the computer mouse, if one is installed on your PC.  Its
use in controlling the ILO292 functions is optional.  The software may be completely
controlled using keystrokes.  These are identified in the User Manual and also by
operating Help keys on important screens.  The TEOAE section of the program offers
two modes of operation, vis a vis the classic keystroke operated ILO88 mode or the V5
drop-down menu mouse operated mode.  To activate the mouse mode within the
TEOAE program, click on the Menu button with the mouse; to revert to the keystroke
mode, select Toolbar off from the Options menu.

Before the mouse can be recognised by the ILO program, you need to set the mouse
active using the ILOCFG program - refer to your ILO Version5 Software Installation
instructions, Configuration, paragraph 7.
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Preparation
Superficially examine the patient’s ear and select a tip size which is appropriate.  Fit
this to the DPOAE probe and gently insert it into the ear.  Check that the probe is
comfortable and that it completely fills the ear canal so that noise may not enter.

Select the DP-Gram option from the Test menu.  Choose
the test resolution.  Remember that higher resolutions
(e.g. 8 points per octave) will take longer to complete.  We
recommend that 3 points per octave be adopted for a
routine first examination, unless time is at a premium,
where lower resolutions may be selected.  Where the DP
audiogram appears to contain wide differences between
adjacent points, higher resolution may be useful in
resolving this.

After selection of the test resolution,
the set-up levels screen is shown.
There are a number of windows.  The
top left window provides the checkfit
function of the ILO88.  It uses a click
stimulus in order to detect anomalies
in probe fitting.  The ear canal
response panel shows the frequency
spectrum of the click stimulus.  This
also helps to reveal anomalies in
probe fit.  Since DPOAE measure-
ment requires two stimuli via two
transducers, it is important that the responses obtained from the two transducers are
similar.  The ear canal response panel superimposes the response from the two
transducers.  If these separate (green and yellow traces), then it may not be possible
for the machine to maintain optimum stimulation during the test.  The test may never-
theless be attempted.  If the probe fit produces strong peaks and valleys in the stimu-
lus spectrum it may not  be possible for the software to maintain the desired stimulus
level.  These regions are indicated by red on the ear canal response panel.

When the click stimulus Checkfit routine has been completed and the probe fit is the
best that can be achieved, pressing the Enter key will result in the DP tones being
presented to the ear.  These will be automatically adjusted to the pre-set level and their
waveform will be displayed on the large central panel.  At this point, the user may
monitor the level of background noise and pre-set the artefact reject arrow with the
cursor keys.  In the event of the machine being unable to set the stimulus levels
correctly, this will prevent progress to the test proper.
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When the probe fit and the stimulus levels are correctly set, the Enter key or the OK
button will take the test on to the main section.

The DP-Gram measurement consists of a series of DPOAE measurements at 2f1-f2
with the stimulus frequency swept between 1K and 6K Hz at steps defined by the
requested resolution.  The frequency sweep is repeated indefinitely and data is
averaged.  As more data is collected, the noise contamination (shown red), will recede
and drop in value, revealing the DPOAE data (white circles) standing above the noise
level.  The noise display is shaded in two sections.  Solid shading encompasses all
levels within one standard deviation of the background noise.  Data points reaching the
limits of this area have a 16% chance of being due to statistical factors and the test
should be continued until a higher level of confidence is achieved.  The lighter shading
red area indicates the limits of the 95% confidence region and is based on two stand-
ard deviations from the background noise.  The test should be continued, if possible, to
obtain a DPOAE point above the 95% limit.
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Normal DPOAEs

Absent DPOAEs
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It is usual for one or two points to suffer more contamination by noise than other
points.  If this is the case, time wasted on well resolved points can be avoided by
pressing the left or right cursor and entering the manual frequency progression mode.
Using the cursors, the test frequency can then be switched to the frequencies most
needing additional time, until the whole DP audiogram is completed.

While the test is in progress, two small panels on the right show the DP as currently
observed, together with a region of frequencies illustrating the current noise levels in
the data.  Also shown is the current level of noise and the stimulus levels maintained in
the ear canal for both f1 and f2.

At any time during the test, the probe fit may be checked by pressing the Probe
Checkfit button with the mouse, or the C key.  This performs an immediate click
stimulus check and allows probe movement to be detected.  If movement is detected
and the test is almost complete, then it should be terminated and saved.  If the test has
not progressed sufficiently, it is recommended that it is aborted and the Checkfit is
repeated.  This is possible by pressing the Go To Checkfit button.

The actual level of DPOAE from a healthy ear can vary widely.  One important factor
determining this is the coupling between the probe and the cochlea via the ear canal
and middle ear.  This factor has little relevance on the hearing of the individual and
therefore no absolute interpretation of the DPOAE level can be made.  However, it is
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normal for healthy ears to have strong DPOAEs of 10dBspl and more.  Young ears and
infants may have levels in excess of 20dBspl.  It is common for ears of older patients
to have smaller DPOAEs and this should be taken into account.  Levels of DPOAE
below 0dBspl may be considered low, but nevertheless provide objective evidence of
cochlear function.

The limiting noise of the instrumentation combined with the 95% confidence limit
recommended, means that DPOAEs less than -10dB cannot be considered valid.  It is,
nevertheless, possible to record DPOAEs below this level.

Choice of stimulus parameters

The relationship between stimuli and the response is complex with DPOAEs.  Full
characterisation of the cochlea’s response would require measurement at multiple
levels, multiple frequencies and multiple frequency ratios.  Time prohibits full investiga-
tion.  As a result of this, there are a number of differing opinions as to the optimum
choice for a single DPOAE measurement.  These issues are addressed in the scientific
literature.  There is, however, general agreement that DPOAEs are most easily de-
tected if the ratio of primary stimulus frequencies is between 1.2:1 and 1.3:1.  The
relative levels of the intensities has a significant effect upon the DPOAE response.  It is
generally agreed that the level of f1 may be equal to or greater than the level of f2 to
advantage.  No advantage has been noted by lowering the level of f1 below that of f2.
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The default setting on the ILO88DP is for f1 and f2 to have equal amplitudes of 70dBspl.
The default frequency ratio is 1.2:2.  These settings can easily be modified.  It is
generally agreed that if lower levels of stimulation are used, then the level at f1 should
be maintained at least 6dB above that of f2 for optimum performance.  f1:f2 intensity
differences as great as 15dB have been used by some workers.

It is strongly recommended that you adopt a stimulus protocol which is well supported
in the scientific literature.  We also recommend that you perform DPOAE measure-
ments on patients with known audiograms and normal ears, in order to familiarise
yourself with the variety of responses that can be obtained.  Please bear in mind that
the clinical value of the DP-Gram rests in the objective evidence it provides of cochlear
function in response to the stimulation tones.  It is generally  agreed that the frequency
of f2 largely defines the region of the cochlea being tested but that this is in no way a
single point within the cochlea and may spread over 20% of the cochlea length.

Validating a DPOAE measurement
Since distortions can be introduced within the instrumentation or the probe, it is
essential to control for the possibility of artefactual distortions being interpreted as
evidence of cochlear function.  We recommend attention to the following points:

1. Regularly perform a DP-Gram in the supplied test cavity, using the stimulus
conditions adopted, to ensure that no visible DP is recorded.  Ephemeral DP data
points can appear in the early stages of recording due to statistical factors.  These
should never exceed -5dBspl and should disappear on continuous monitoring.  In
the event that DP signals are observed within the cavity, the OAE probe should first
be suspected and exchanged if possible.  Because of the nature of distortion,
deterioration of a probe will first become apparent at the higher levels of stimula-
tion.  A probe which does not produce any artefactual distortion in a cavity run at
70dBspl can be relied upon not to produce artefactual distortion at lower levels.

2. Because individual ears present unique acoustic environments for the acoustic
probe, the cavity test (‘1’ above) cannot be wholly relied upon.  In the case that the
probe passes the cavity test but nevertheless there is a limited region of frequen-
cies in which the patient apparently produces DPOAEs which are absent over
extended regions, it is necessary to confirm that the apparent DPOAE is of coch-
lear origin.  This is particularly important when the system is used near to the
maximum recommended stimulus levels.

This check can be achieved by observing the latency of arrival of a distortion
product relative to the stimuli.  In all cases of local distortion in the instrumentation
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or the probe, the latency of arrival would be close to zero.  In the case of physi-
ological DPOAEs which emanate from the cochlea, there would be a latency of at
least 2.5ms.  This latency is the basis of the ILO88 Transient OAE test and there-
fore incorporated within the ILO88DP test.  To activate the latency check, the item
is ticked in the test menu.  The DP-Gram is then re-run with the latency checking in
progress.
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The latency check is achieved by slightly altering the frequencies on alternate meas-
urements and recording the phase change observed.  If the measured latency is less
than 2.5ms, the offending point is highlighted and coloured red.  A data point put in
doubt in this way should be confirmed, preferably by using stimuli of slightly differing
frequency.  Failure to obtain a latency checked DPOAE point should result in the DP-
Gram being regarded with suspicion.  Further audiological investigation should then be
undertaken to test the ear.

DPOAE validity may also be checked by measurement of the gradient with respect to
input level.  Artefactual DPOAEs due to overload of the probe or instrumentation
system are characterised by a very rapid growth of DPOAE with input level.

To activate the gradient check, this item is ticked on the test menu.  The DP-Gram is
then re-run and the gradient check is automatically implemented.  This is achieved by
changing the level of stimulation between  alternate measurements by 6 or 10dB.  If a
gradient greater than 2 is detected, the offending point is highlighted and coloured red.
In this case, the user is recommended to attempt to reconfirm the point by using a
slightly different frequency condition.  If the point cannot be confirmed, then the
DPOAE data must be considered suspect and audiological investigation undertaken to
asses the ear.

In the case that a latency check has shown a point to be invalid, then the probe
calibration should be immediately repeated to ensure that the probe is not defective.
In the case of a gradient check failure, the probe and system should also be checked,
but this is less urgent since gradient check failure can occasionally result from normal
interference effects within the cochlea.  As these are confined to specific frequency
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combinations, it is likely that the gradient failure will occur only on single points and be
eliminated by a minor change in frequency.

It cannot be over-emphasised that when a DP-Gram is used for screening, every care
must be taken to ensure that DP points remain valid.  Low levels of DP confined to
limited frequencies should be confirmed before this is taken as evidence of general
cochlear health.  Conversely, the absence of a small region of response in an other-
wise strong DP-Gram should not be taken as an indication of a defect or dip in the
audiogram at that frequency.  Complex interference effects can cause distortions of the
DP-Gram in limited regions.

Finally, it should be noted that a DP-Gram does not measure the entire function of the
cochlea since it does not test the transduction of the signal into the auditory nerve.
DPOAEs can confirm cochlear function at the sensory level but cannot confirm hear-
ing.  It follows also that the level of DPOAE is not well correlated to the auditory
threshold of the individual.

Use of the DP Spectrum
The DP Spectrum display provides a full analysis of the response of the ear canal to a
pair of fixed stimulus tones.  The DPOAE 2f1-f2 can usually be clearly seen in this
display and the characteristics of the noise contamination can also be assessed.

In this display, the additional Distortion Products which are naturally present, e.g.
2f20f1, 3f1-f2, are highlighted in blue to distinguish them from noise components, which
are coloured red.

The DP Spectrum is useful to
extract evidence of DPOAEs
in noisy conditions or when
the DPOAE is small or
doubtful.  Use of a fixed
frequency pair maximises
collection efficiency.  In the
DP-Gram only a proportion of
the time available is spent
looking at each point.  We
recommend that a DP-Gram
is always performed first and
that no conclusion is made
about the condition of an ear
based on a single DP Spec-
trum measurement.



3-30 ILO OAE Instrument User Manual Issue 5a : October 1997

Use of the patient noise monitoring
headphone

The ILO292 DP Echoport provides for the audio monitoring of noise received by the
OAE probe microphone while placed in the patient’s ear.  For this, a standard
Walkman headphone (supplied) is fitted to the rear jack socket on the DP Echoport.
The headphone is live to the microphone signal only during the Checkfit stage of
operation of the ILO88 DP software.  When not in use, the headphone plug should be
removed from the DP Echoport.  If the headphones are left in close proximity to the
OAE probe, the possibility of audio feedback exists.  This will take the form of a
whistle.  No damage will be caused by this feedback and it will cease immediately the
probe is placed in the patient’s ear.  We do, however, advise that the monitoring
headphone is used only when necessary to diagnose the cause of noisy recording.
The jack sockets should  not be connected to any external device other than the
headphones supplied.

Often, OAE recordings are impossible or are degraded by the presence of noise.  It is
not always evident from the OAE monitoring screen what is the cause of the noise.
For example, the ingress of background noise from air conditioning may appear on the
ILO screen as indistinguishable from the sound of breathing or swallowing by the baby
or patient.  In fact, the remedy for the noise differs markedly in the two cases and they
can readily be distinguished by listening to the offending sound through the earphone.
Many other sources of noise have been reported, including electrical detection of radio
broadcasts and otherwise inaudible vocalisations by the patient!  In any event, the
solution to the noise problem will be more evident once the sound is listened to.
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PART FOUR
Appendices
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APPENDIX 1
Otodynamics Probes & Accessories - Identification

Transient probes
All Transient probes are available in both 5-pin and 8-pin versions.

SNS: Newborn (blue)
serviceable

SGS: General Purpose (red)
serviceable

BS: Adult
standard

Service accessories
n TPC transient probe replacement coupler tubes for SNS & SGS

n BNS replacement body and lid for newborn serviceable probe

n BGS replacement body and lid for general purpose serviceable probe
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Distortion Product/Transient probes
All DP probes are 8-pin variety and require an adaptor for 5-pin usage which is
supplied free on request.

HP: Newborn
standard DP

CD: Child
standard DP

BP: Adult
standard DP

Probe tips

Twin-tube Transient OAE tips (T)
T3E Twin-holed elliptical tip, fits 3mm ear canal, elliptical shaped

end.  (Formerly known as ‘small’).  Designed for small and
premature newborns.

T4.5C Twin-holed conical tip, fits 4 to 5mm ear canal.  (Formerly known
as ’medium’).  Suitable for small newborns.

T5.5B Twin-holed blob shaped tip, fits 5.5mm ear canal. (Formerly
known as ’large’).  Suitable for most newborns.

T6.5B Twin-holed blob shaped tip, fits 6.5mm ear canal.  Suitable for
large newborns and first year infants.

T8M Twin-holed mushroom shaped tip, fits 8 to 8.5mm ear canal.
(Formerly known as ‘extra-large’).  Designed for infants and small
adults.

T9M Twin-holed mushroom shaped tip, fits 9 to 10 mm ear canal.
Designed for most adults.

T11M* Twin-holed mushroom shaped tip, fits larger ear canal.
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Cloverleaf DPOAE tips (C)
C4.5C Cloverleaf-holed conical tip, fits 4 to 5mm ear canal.  (Formerly

known as ’medium’).  Suitable for newborns.

C5.5B Cloverleaf-holed blob shaped tip, fits 5.5mm ear canal. (Formerly
known as ’large’).  Suitable for newborns.

C8M Cloverleaf mushroom shaped tip, fits 8 to 8.5mm ear canal.
(Formerly known as ‘extra-large’).  Designed for infants and small
adults.

Round-tube TE/DPOAE tips (R)
R4.5C* Round-holed conical tip, fits 4 to 5mm ear canal. Replacement for

C4.5C. Suitable for newborns.

R5.5B* Round-holed blob shaped tip, fits 5.5mm ear canal. Replacement
for C5.5b.  Suitable for newborns.

R9.5F Round-holed foam shaped tip, fits 9.5 to 10.5mm ear canal.
Suitable for adults.  For use with adult single and adult dual
channel probes.

NB: * Not yet available.
The sound intensity provided by the neonatal probe is
limited by a 20dB attenuator.

All the Otodynamics Ltd. probe tips are disposable and should be discarded after use.
DO NOT sterilize probe tips as this may result in retention of the solution within the tip,
which may damage your probe.
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APPENDIX 2
Probes - Cleaning

The following is the suggested method of cleaning the Otodynamics ILO neonatal
probes. It should be noted that the probe is a precision assembly and as such care
should be taken throughout in its handling and cleaning.

Cable
Cables may be cleaned with antiseptic fluid or wipes.

Probe casing
We recommend that the probe casing is cleaned using antiseptic wipes and dried with
a tissue immediately afterwards.  Avoid liquids entering the sound tubes.

Coupler assembly
Each coupler assembly has at least two sound tubes. These are protected from
ingress of foreign materials by the disposable probe tip. At the end of each tube a
loudspeaker or microphone is found.  Cleaning solution must not penetrate the tubes.
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Serviceable probes
Serviceable probes have the sound tubes combined into a single coupler assembly, so
that they can easily be replaced.  This enables users to fit new couplers at intervals as
a preventive measure and to deal with contaminated tubes.  Apart from the new
servicing procedure, the usage of these probes is exactly the same as for the non-
serviceable equivalents and should always be as per the OAE system user documen-
tation.  The probe is supplied with five spare coupler assemblies, a spare body and lid,
and a range of tips.

This guide gives instructions on disassembling and reassembling serviceable probes.
They can be identified by the serial number on the cable sleeve near the plug, which
begins with the letter ‘S’.  Newborn probes use a lower drive level to compensate for
the smaller ear canal and it is important to use the correct probe type for a particular
subject.  Probes are therefore also colour coded according to their usage:

n Newborn serviceable probes are blue, with a serial number beginning ‘SN’.

n General purpose serviceable probes are red, with a serial number beginning ‘SG’.

Because serviceable probes have body and lid mouldings which must be removed
from the probe for servicing, it is essential that probes are reassembled without mixing
bodies and lids of one type with inner transducer assemblies of a different type.  For
this reason the body, lid and inner transducer assembly of each probe is made the
same colour, so that users can be certain of component identity by ensuring matching
colours.  The OAE system display also indicates the sound level achieved in the ear
canal, which should always be monitored during testing to ensure it is correct.   An
excessively high sound level is positively indicated by a warning message flashed onto
the screen, providing an additional safeguard.

This guide also gives instructions on an occlusion test which must be carried out by
the user after servicing, in conjunction with a probe cavity test, in order to confirm
correct probe function.

Disassembling the probe
First, unplug the probe from the system.  Remove the tip by pulling off as shown in Fig.
1, then remove the lid by lifting the tab on the cable edge of the lid, also shown in Fig.
1, and remove the inner transducer assembly by pushing the coupler tubes down onto
a hard surface, as shown in Fig. 2, then pulling out the inner transducer assembly by
gripping it as shown in Fig. 3.  Never remove it by pulling on the cable.  Finally, pull the
coupler assembly away from the inner transducer assembly as shown in Fig. 4.  If the
coupler assembly stays inside the body section of the outer shell, remove it with
tweezers.
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Reassembling the probe
Fit the coupler assembly to the inner transducer assembly as shown in Fig. 1, ensuring
that the  coupler has a red/orange component in the longer tube; this is important for
correct sound level.  Fit the body section of the outer shell as shown in Figs. 2 and 3,
followed by the lid section of the outer shell, as shown in Fig. 4.  Be sure to engage the
edge of the lid opposite the tab first, with the tab aligned with the cable, and then click
the lid into place using firm finger pressure only. After testing as described in the
section below, fit the tip as shown in Fig. 4.

Testing after servicing
After reassembling the probe it is essential to carry out an
occlusion test and a probe cavity test to confirm correct
probe function.  The occlusion test must be carried out
without a tip fitted to the probe.  Set the OAE system to
checkfit and press a finger firmly over the end of the
coupler assembly, closing both sound tubes. There should
be no visible stimulus waveform or FFT.  If either is visible
then this indicates sound leakage inside the probe,
caused by incorrect assembly, in which case the probe
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assembly must be corrected and confirmed by re-test.  If all is well carry out a probe
cavity test before use, following the instructions in your system user documentation.

When to service
As with all probes it is important to:

n fit a new tip for each test
n visually check for unobstructed sound tubes when fitting the tip
n observe screen feedback during checkfit and testing to detect signs

of contamination, e.g. low stimulus and/or response levels
n carry out regular probe cavity tests.

If contamination is visible at the open ends of the sound tubes it is permissible to
remove it with a fine wire, following standard practice for audiological probes; at any
sign of contamination which cannot be dealt with in that way, fit a new coupler.  In
order to minimise downtime, we recommend fitting a new coupler at regular intervals
as a preventive measure.  The interval between changes will depend on the intensity
of your testing program and the experience of the operators.  For experienced opera-
tors once every one or two hundred tests may be appropriate; if you are less experi-
enced then once every fifty tests might be a suitable starting point.  If you need more
couplers please contact your dealer.

Remember the coupler is designed as a low cost disposable part - if in doubt replace
it!  Do not attempt to clean the coupler as this may damage the acoustic filter.

Remember!

DO n Use disinfectant wipes to clean probe shell
n Discard all tips after use
n Carefully remove wax using fine wire hook if ingress has occurred
n Check calibration regularly
n Change the sound tubes of serviceable probes regularly, or if

they become contaminated

DO NOT n Bend the cable near probe tip
n Allow wax to be pushed up tubes
n Use any liquid to clean the probe shell - liquid must not be

allowed to enter the probe tube
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APPENDIX 3
Error Messages

2 File not found
3 Path not found
4 Too many open files
5 File access denied
6 Invalid file handle

12 Invalid file access code
15 Invalid drive number
16 Cannot remove current directory
17 Cannot rename across drives
18 No more files

100 Disk read error
101 Disk write error
102 File not assigned
103 File not open
104 File not open for input
105 File not open for output
106 Invalid numeric format
150 Disk is write-protected
151 Bad drive request struct length
152 Drive not ready
154 CRC error in data
156 Disk seek error
157 Unknown media type
158 Sector Not Found
159 Printer out of paper
160 Device write fault
161 Device read fault
162 Hardware failure
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APPENDIX 4
ILO Codes

[0] = Not Autostopped

[1 = LongTime

[2] = ManyRejects

[3] = MuchData

[4] = HighStimulus

[5] = LowStimulus

[6] = LowStability

[7] = MuchNoise

[8] = DeadNoise

[9] = GoodRespdB

[10] = GoodRepro

[11] = ReachedNois; {will add SNR score”, in tops}

[12] = GoodSNR

[13] = GoodQuality

[14] = Reserved

[15] = OperatorEnded


